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About This Guide

IMPORTANT! Before using this product, read and understand the information the
“Safety” appendix in this document.

Revision history

Revision Date Description

A 1999 New document.

B 2001 —

C 2005 —

D 2006 —

E 2006 Change to limited licensing information.

F 2011 Change to limited licensing information.

G March 2012 Change to copyright page information.

H August 2012 e Add validation experiments and results for
buffer and enzyme kit component changes.

e Update instrument and software instructions.

Purpose

The Applied Biosystems AmpF(STR™ SGM Plus'™ PCR Amplification Kit User
Guide provides information about the Applied Biosystems instruments,

chemistries, and software associated with the AmpF(STR™ SGM Plus"" PCR
Amplification Kit.

User attention words

Five user attention words may appear in this document. Each word implies a
particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation
or accurate chemistry kit use.

AmpFtSTR™ SGM Plus™ PCR Amplification Kit User Guide 9



About This Guide
User attention words

CAUTION! Indicates a potentially hazardous situation that, if not avoided, may
result in minor or moderate injury. It may also be used to alert against unsafe
practices.

WARNING! Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.
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B Product OVErVIEW . . ...t e e 11
B WOrKflOw OVEIVIEW . ..ottt e e et e 15
B Instrument and software OVerview .............c.coviiiiiiiiin .. 16
B Materials and equipment ............. . i 18

Product overview

Purpose

Product
description

About the primers

Loci amplified by
the kit

The AmpF(STR"™ SGM Plus PCR Amplification Kit is a short tandem repeat (STR)
multiplex assay that amplifies 10 tetranucleotide repeat loci (D351358, vVWA, D16S539,
D251338, D8S1179, D21S11, D18S51, D195433, THO1, FGA) and the Amelogenin
gender-determining marker in a single PCR amplification.

The SGM Plus™ Kit contains all the necessary reagents for the amplification of human
genomic DNA.

The reagents are designed for use with the following Applied Biosystems instruments:
* Applied Biosystems 3100/3100-Avant Genetic Analyzer
¢ Applied Biosystems 3130/3130x! Genetic Analyzer
* Applied Biosystems 3500/3500xL Genetic Analyzer
* Applied Biosystems 310 Genetic Analyzer
* GeneAmp'" PCR System 9700 with the Silver 96-Well Block
* GeneAmp " PCR System 9700 with the Gold-plated Silver 96-Well Block
e Veriti'" 96-Well Thermal Cycler

The SGM Plus™ Kit employs the same primer sequences for all loci common to other
AmpF(STR™ kits (except the MiniFiler'" kit), but does not include the degenerate
unlabeled primer for the D851179 locus that was included in later AmpF(STR™ kits (for
more information, see the AmpF(STR™ Identifiler PCR Amplification Kit User Guide).

The following table shows the loci amplified, their chromosomal locations, and the
corresponding fluorescent marker dyes. The AmpF(STR™ SGM Plus'" Allelic Ladder is
used to genotype the analyzed samples. The alleles contained in the allelic ladder and
the genotype of the AmpF(STR™ Control DNA 007 are also listed in the table.

AmpFtSTR™ SGM Plus™ PCR Amplification Kit User Guide 11



Product overview

Chapter 1 Overview

Table1 SGM Plus™ Kit loci and alleles

Locus designation Chromosome Alleles included in AmpF{(STR™ Dye ControlDNA
9 location SGM Plus™ Allelic Ladder label 007
D351358 3p 12, 13, 14, 15, 16, 17, 18, 19 5-FAM™ 15, 16
vWA 12p12-pter 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 14, 16
23, 24
D165539 16q24-qter 5,8,9 10,11, 12,13, 14, 15 9,10
D251338 2q35-37.1 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 20, 23
27, 28
Amelogenin X: p22.1-22.3 XY JOE™ XY
Y: p11.2
D851179t 8 8,9,10, 11,12, 13, 14, 15, 16, 17, 18, 19 12,13
D21S11 21911.2-921 24, 24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, 28, 31
30.2, 31, 31.2, 32, 32.2, 33, 33.2, 34, 34.2, 35,
35.2, 36, 37, 38
D185S51 18qg21.3 7,9, 10, 10.2, 11, 12, 13, 13.2, 14, 14.2, 15, 12, 15
16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27
D195433 19912-13.1 9,10, 11, 12, 12.2, 13, 13.2, 14, 14.2, 15, NED™ 14, 15
15.2, 16, 16.2, 17, 17.2
THO1 11p15.5 4,5,6,7,8, 9 93,10, 11, 13.3 7, 9.3
FGA 4928 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, 27, 24, 26

28, 29, 30, 30.2, 31.2, 32.2, 33.2, 42.2, 43.2,
44.2, 452, 46.2, 47.2, 48.2, 50.2, 51.2

T In some literature references, this locus is designated as D65502.

Allelic ladder
profile

12

Figure 1 shows the allelic ladder for the SGM Plus"" Kit. See “Allelic ladder
requirements” on page 25 for information on ensuring accurate genotyping.
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Chapter 1 Overview
Product overview

Figure 1 GeneMapper™ ID-X Software plot of the AmpF(STR™ SGM Plus™ Allelic Ladder
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Product overview
Control DNA 007 Figure 2 shows amplification of Control DNA 007 using the SGM Plus'" Kit.

profile

Figure 2 1 ng of Control DNA 007 amplified with the SGM Plus™ Kit and analyzed on the Applied Biosystems 3130x!
Genetic Analyzer
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Chapter 1 Overview
Workflow overview

Workflow overview

Perform
PCR

Perform
electro-
phoresis

l
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Chapter 1 Overview
Instrument and software overview

Instrument and software overview

Data Collection

and GeneMapper™

ID or ID-X
Software

Instrument and
software
compatibility

About
multicomponent
analysis

16

This section provides information about the Data Collection Software

versions required to run the AmpF(STR™ SGM Plus™ PCR Amplification Kit
on specific instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data

Collection Software collects the data and stores it. The Data Collection Software stores

information about each sample in a sample file (.fsa), which is then analyzed by the
GeneMapper " ID or ID-X Software.

Table 2 Software specific to each instrument

Instrument Operating Data Collection Analysis software
system Software
3500/3500xL e Windows™ XP | 3500 Series GeneMapper™ ID-X
o Windows Data Collection | Software v1.2 or higher
Vista™ Software v1.0
3130/3130x! Windows™ XP 3.0 e GeneMapper™ ID
Soft 3.2.1
3100/3100-Avant | Windows™ NT 1.1 (3100) orware v

1.0 (3100-Avant)

Windows™ 2000

2.0

310

Windows™ XP

3.1

and
o GeneMapper™ ID-X
Software v1.0.1 or higher

e Windows™ NT | 3.0

e Windows™
2000

Note: We conducted validation studies for the AmpF(STR™ SGM Plus™ PCR
Amplification Kit using the Applied Biosystems 310 Genetic Analyzer running Mac

Operating System'". This configuration is now obsolete.

Applied Biosystems fluorescent multi-color dye technology allows the analysis of
multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different
colored dyes.

Multicomponent analysis is the process that separates the four different fluorescent

dye colors into distinct spectral components. The three dyes used in the SGM Plus™
Kit to label samples are 5-FAM™, JOE™, and NED"" dyes. The fourth dye, ROX"" dye,
is used to label the GeneScan'" 500 ROX ™ Size Standard.

AmpFISTR™ SGM Plus™ PCR Amplification Kit User Guide



Chapter 1 Overview 1
Instrument and software overview

How Each of these fluorescent dyes emits its maximum fluorescence at a different
multicomponent wavelength. During data collection on the Applied Biosystems and Applied
Biosystems instruments, the fluorescence signals are separated by diffraction grating
according to their wavelengths and projected onto a charge-coupled device (CCD)
camera in a predictably spaced pattern. The 5-FAM'" dye emits at the shortest
wavelength and it is displayed as blue, followed by JOE™ (green), NED"" (yellow), and
ROX™ (red) dyes.

analysis works

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure 3).
The goal of multicomponent analysis is to correct for spectral overlap.

Figure 3 Emission spectra of the four dyes used in the AmpF(STR™ SGM Plus™ Kit
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Materials and equipment

Materials and equipment

Kit contents and The AmpF(STR™ SGM Plus™ PCR Amplification Kit (Part no. 4307133) contains
storage materials sufficient to perform 100 amplifications at 50 pL/amplification.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Component Description Volume Storage
AmpFeSTRTM PCR Contains MgCl,, dNTPs, and bovine serum 2 tubes, 1.1 mL | -15 to -25°C on receipt,
Reaction Mix albumin in buffer with 0.05% sodium azide. | each 2 to 8°C after initial use
AmpF(STR™ SGM Plus ™ | Contains fluorescently labeled primers and | 1 tube, 1.1 mL
Primer Set non-labeled primers.

AmpF(STR™ SGM Plus™ | Contains amplified alleles. 1 tube, 0.05 mL

Allelic Ladder See Table 1 on page 12 for a list of alleles

included in the allelic ladder.

AmpF(STR™ Contains 0.10 ng/pL human male 007 DNAin | 1 tube, 0.3 mL
Control DNA 007 0.05% sodium azide and buffer®.
See Table 1 on page 12 for profile.
AmpliTag Gold™ DNA Contains enzyme, with an activity of 5 U/uL. | 2 tubes, -15 to -25°C
Polymerase 0.05 mL/tube

+ The AmpF(STR™ Control DNA 007 is included at a concentration appropriate to its intended use as an amplification control [i.e., to provide
confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpF(STR™ Control DNA 007 is not designed
to be used as a DNA quantitation control, and you may see variation from the labelled concentration when quantitating aliquots of the
AmpF(STR™ Control DNA 007.

Standards for For the SGM Plus™ Kit, the panel of standards needed for PCR amplification,
samples PCR product sizing, and genotyping are:

e AmpF(STR™ Control DNA 007 - A positive control for evaluating the efficiency

of the amplification step and STR genotyping using the AmpF(STR™ SGM Plus "™
Allelic Ladder.

e GeneScan"" 500 ROX™ Size Standard — Used for obtaining sizing results. This
standard, which has been evaluated as an internal size standard, yields precise

sizing results for SGM Plus™ Kit PCR products. Order the GeneScan™ 500 ROX™
Size Standard (Part no. 4322682) separately.

e AmpF(STR™ SGM Plus ™ Allelic Ladder — Allelic ladder developed by Life

Technologies for accurate characterization of the alleles amplified by the SGM

Plus™ Kit. The AmpF(STR™ SGM Plus™ Allelic Ladder contains most of the
alleles reported for the 10 autosomal loci. Refer to Table 1 on page 12 for a list of

the alleles included in the AmpF/STR"™ SGM Plus™ Allelic Ladder.

18 AmpFISTR™ SGM Plus™ PCR Amplification Kit User Guide
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Required user-supplied reagents

In addition to the SGM Plus™ Kit reagents, the use of low-TE buffer (10 mM Tris,
0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as described in the
procedure below or order it from Teknova (Cat # T0223).

To prepare low-TE buffer:
1. Mix together:
e 10mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA quantification

Importa nce of Quantifying the amount of DNA in a sample before amplification allows you to

quantification determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount of
DNA for the SGM Plus™ Kit is 1.0-2.5 ng in a maximum input volume of 20 uL for 28
PCR cycles.

AmpFtSTR™ SGM Plus™ PCR Amplification Kit User Guide 19



Chapter 2 Perform PCR
DNA quantification

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

¢ Fluorescence intensity that exceeds the linear dynamic range for detection by the

instrument (“off-scale” data). Off-scale data are problematic because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

¢ Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur resulting in a partial profile.

Methods of
quantifying DNA

Life Technologies provides several kits for quantifying DNA in samples. See the
reference cited in the following table for details about these kits.

Product

Description

Quantifiler™ Human DNA
Quantification Kit
(Part no. 4343895)

and

Quantifiler™ Y Human Male
DNA Quantification Kit
(Part no. 4343906)

For more information, see
Quantifiler ™ Human DNA
Quantification Kits User's Manual
(Pub. no. 4344790)

Quantifiler™ Duo DNA
Quantification Kit
(Part no. 4387746)

For more information, see
Quantifiler™ Duo DNA
Quantification Kit User's Manual
(Pub. no.4391294)

Properties:

The Quantifiler™ Human and Quantifiler™ Y Human Male Kits are highly specific for
human DNA, and they individually detect total human or male DNA, respectively. The
kits detect single-stranded and degraded DNA.

How they work:

The Quantifiler™ DNA Quantification Kits consist of target-specific and internal control
5" nuclease assays.

The Quantifiler™ Human and Quantifiler™ Y Human Male Kits contain different
target-specific assays (human DNA or human male DNA, respectively) that each
consist of two locus-specific PCR primers and one TagMan™ MGB probe labeled with
FAM™ dye for detecting the amplified sequence. The kits each contain a separate
internal PCR control (IPC) assay, which consists of an IPC template DNA (a synthetic
sequence not found in nature), two primers for amplifying the IPC template, and one
TagMan™ MGB probe labeled with VIC™ dye for detecting the amplified IPC.

Properties:

The Quantifiler™ Duo Kit is highly specific for human DNA. This kit combines the
detection of both total human and male DNA in one PCR reaction.The kit detects single-
stranded and degraded DNA.

How it works:

The Quantifiler™ Duo DNA Quantification Kit consists of target-specific and internal
control 5" nuclease assays.

The Quantifiler™ Duo kit combines two human-specific assays in one PCR reaction (for
total human DNA and human male DNAJ. The two human DNA specific assays each
consist of two PCR primers and a TagMan™ probe. The TagMan™ probes for the human
DNA and human male DNA assays are labeled with VIC™ and FAM™ dyes, respectively.
In addition, the kit contains an internal PCR control (IPC) assay similar in principle to
that used in the other Quantifiler kits, but labeled with NED™ dye.

20
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Chapter 2 Perform PCR 2
Prepare the amplification kit reactions

Prepare the amplification kit reactions

1. Calculate the volume of each component needed to prepare the reactions, using

the table below.
DNA sample Volume per reaction
AmpF(STR™ PCR Reaction Mix 21.0 uL
AmpF(STR™ SGM Plus ™ Primer Set 11.0 pL
AmpliTag Gold™ DNA Polymerase 1.0 pL

Note: The volumes above include a slight overfill to provide excess volume for
the loss that occurs during reagent transfers.

2. Prepare reagents. Thaw the AmpF(STR™ PCR Reaction Mix and the SGM Plus™
Primer Set, then vortex all reagent tubes including the enzyme for 3 seconds and
centrifuge briefly before opening the tubes.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2 to 8°C and, therefore, they do not require subsequent
thawing. Do not refreeze these reagents.

3. Pipette the required volumes of components into an appropriately sized
polypropylene tube to create a master mix.

4. Vortex the master mix for 3 seconds, then centrifuge briefly.

5. Dispense 30 pL of the reaction mix into each reaction well of a
MicroAmp ' Optical 96-Well Reaction Plate or each MicroAmp"" tube.

6. Prepare the DNA samples:

DNA sample To prepare...
Negative control | Add 20 pL of low-TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).
Test sample Dilute a portion of the test DNA sample with low-TE buffer so

that 1.0-2.5 ng of total DNA is in a final volume of 20 pL. Add
20 pL of the diluted sample to the reaction mix.

Positive control Add 20 pL of 007 control DNA (0.1 ng/pL).

The final reaction volume (sample or control plus master mix) is 50 pL.

7. Seal the MicroAmp"" Optical 96-Well Reaction Plate with MicroAmp™ Clear
Adhesive Film or MicroAmp ' Optical Adhesive Film, or cap the tubes.

8. Centrifuge the tubes or plate at 3000 rpm for ~20 seconds in a tabletop centrifuge
(with plate holders if using 96-well plates).

9. Amplify the samples in a GeneAmp'" PCR System 9700 with the silver or gold-
plated silver 96-well block or a Veriti' " 96-Well Thermal Cycler.
Note: The SGM Plus"" Kit is not validated for use with the GeneAmp PCR System
9700 with the aluminium 96-well block. Use of this thermal cycling platform may
adversely affect performance of the SGM Plus™ Kit.
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Select the correct PCR cycle number

Select the correct PCR cycle number

All AmpF(STR™ kits are optimized for a specific number of amplification cycles to
deliver well-balanced and high quality results. However, increases in the number of
low-level DNA samples being submitted for analysis have prompted many
laboratories to evaluate increasing the number of amplification cycles to increase the
sensitivity of the assay. Before increasing the cycle number, perform a comprehensive
validation study to establish new performance criteria for the higher cycle number.
Higher cycle numbers can cause the following to occur:

¢ Exaggerated stochastic effects resulting from low DNA input amounts

* Greater difference between the presence and absence of an allele

* Greater heterozygote peak imbalance

* Possible differences in expected stutter position and percentage

* DPossible increase in artifacts and/or background in the profile to accompany the

increase in sample allele signal

The AmpF(STR™ SGM Plus™ PCR Amplification Kit is optimized for 28 cycles
of amplification only.

The results of developmental validation studies are shown in “Developmental
Validation” on page 66.

Perform PCR

1. Program the thermal cycling conditions:

* When using the GeneAmp'" PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

*  When using the Veriti'* 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti'" 96-Well Thermal Cycler
AmpF(STR™ Kit Validation (Pub. no.4440754).

Initial Melt Anneal Extend Final Final
incubation step extension hold
HOLD CYCLE (28) HOLD HOLD
95°C 94°C 59°C 72°C 60°C 25°C
11 min 1 min 1 min 1 min 45 min )

2. Load the plate into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure to
place a MicroAmp™ compression pad (Part no. 4312639) on top of the plate to
prevent evaporation during thermal cycling. The Veriti"" Thermal Cycler does
not require a compression pad.

3. Start the run.
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Amplification using bloodstained FTA™ cards

4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
< 2 weeks 2 to 8°C
> 2 weeks -15t0 -25°C

IMPORTANT! Store the amplified products so that they are protected from light.

Amplification using bloodstained FTA™ cards

FTA™ cards can be useful for collecting, storing, and processing biological samples.
A small punch disc of the card containing the sample can be placed directly into an
amplification tube, purified, and amplified, without transferring the disc. Our studies
indicate that a 1.2-mm bloodstained disc contains approximately 5-20 ng DNA. An
appropriate cycle number for this high quantity of DNA is 25 cycles as determined by
our validation studies. However, it is recommended that each laboratory determine
the optimum cycle number based on internal validation studies.

In the example shown in Figure 4, a 1.2-mm disc of a bloodstained FTA card was
purified using three washes with FTA Purification Reagent and two washes with

1X low-TE buffer. The purified punch disc was then amplified in a MicroAmp ' tube
for 25 cycles.

Figure 4 AmpF(STR™ SGM Plus™ Kit PCR Amplification Kit results from a 1.2-mm FTA bloodstain disc (25-
cycle amplification), analyzed on the Applied Biosystems 3130x! Genetic Analyzer
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Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of allelic . _Ong Number of samples per
Instrument injection .
ladders to run equals allelic ladder(s)

3100-Avant or 3130 | 1 per 4 injections 4 samples 15 samples + 1 allelic ladder

3100 or 3130x{ 1 per injection 16 samples | 15 samples + 1 allelic ladder
3500 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples | 23 samples + 1 allelic ladder
310 1 per 10 injections | 1sample 9 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.
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Allelic ladder requirements

It is critical to genotype using an allelic ladder run under the same conditions as the
samples because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.
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Section 3.1 3100/3100-Avant and 3130/3130xl instruments
Set up the 3100/3100-Avant or 3130/3130x! instrument for electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x!
instruments

Set up the 3100/3100-Avant or 3130/3130x! instrument for
electrophoresis

Reagents and parts

Electrophoresis
software setup and

“Ordering Information” on page 117 lists the required materials not supplied with the
AmpF(STR™ SGM Plus™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

The following table lists Data Collection Software and the run modules that can be

used to analyze SGM Plus'" Kit PCR products. For details on the procedures, refer
to the documents listed in the table.

reference
documents
Genetic Data Operatin
Collection P Run modules and conditions References
Analyzer g System
Software
Applied 3.0 Windows™ ¢ HIDFragmentAnalysis36_POP4_1 Applied Biosystems 3130/3130x(
Biosystems XP Injection conditions: Genetic Analyzers Using Data Collection
3130/3130x! Software v3.0, Protocols for Processing
- 3130 =3 kV, ’
3130 = 3 kV/5 sec AmpFESTR™ PCR Amplification Kit PCR
- 3130x( = 3 kV/10 sec Products User Bulletin
e Dye Set F (Pub. no. 4363787)
Applied 2.0 Windows™ e HIDFragmentAnalysis36_POP4_1 3100/3100-Avant Genetic Analyzers
Biosystems 2000 Injection condition: 3kV/10 sec Using Data Collection Software v2.0,
3100 « Dye SetF Protocols for Processing AmpF(STR™
PCR Amplification Kit PCR Products
User Bulletin (Pub. no. 4350218)
1.1 Windows™ e GeneScan36_POP4DyeSetF 3100/3100-Avant Genetic Analyzers
NT Injection condition: 3kV/10 sec Protocols for Processing AmpF(STR™
R . PCR Amplification Kit PCR Products
G5500Analysis.gsp User Bulletin [Pub. no. 4332345)
Applied 1.0 Windows™ = e GeneScan36A_POP4DyeSetFModule | 3700/3100-Avant Genetic Analyzers
Biosystems NT Injection condition: 3 kV/5sec Protocols for Processing AmpF(STR™
3100-Avant e GS500Analysis.as PCR Amplification Kit PCR Products
yeIsgsp User Bulletin [Pub. no. 4332345
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Chapter 3 Electrophoresis

Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x! instrument

Prepare samples for electrophoresis on the 3100/3100-Avant or
3130/3130x! instrument

Prepare the samples for electrophoresis on the 3100/3100-Avant or 3130/3130x!
instrument immediately before loading.

28

1.
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Calculate the volume of Hi-Di'" Formamide and size standard needed to prepare
the samples:

Reagent Volume: per
reaction
GeneScan™ 500 ROX™ Size Standard 0.5 pL
Hi-Di™ Formamide 8.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

™

Into each well of a MicroAmp ~ Optical 96-Well Reaction Plate, add:
* 9 uL of the formamide:size standard mixture
* 1 pL of PCR product or allelic ladder

Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

Seal the reaction plate with appropriate septa, then centrifuge the plate to ensure
that the contents of each well are collected at the bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.
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Set up the 3500/3500xL igshtffrtni:)? foEl:l(;tcrt(;E;hoorrii:
Section 3.2 3500/3500xL Series instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 117 lists the required materials not supplied with the
AmpF(STR™ SGM Plus™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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Electrophoresis The following table lists Data Collection Software and the run modules that can be

software setupand  used to analyze SGM Plus™ Kit PCR products. For details on the procedures, refer
to the documents listed in the table.

reference
documents
Genetic Data Operatin
Analvzer Collection 2 stemg Run modules and conditions References
¥ Software y
Applied 3500 Data = Windows™ e HID36_POP4 Applied Biosystems 3500/3500xL
Biosystems Collection XP Injection conditions: 1.2kV/15 sec Genetic Analyzer User Guide
3500 Software or « Dye SetF (Pub. no. 4401661)
Applied v1.0 Windows e HID36 POP4 Applied Biosystems 3500 and 3500xL
Biosystemns Vista ™ I _ ditions: 1.2kV/24 Genetic Analyzers Quick Reference
25000 njection conditions: 1. sec Card (Pub. no. 4401662)
e Dye Set F

Prepare samples for electrophoresis on the 3500/3500xL
instrument
Prepare the samples for electrophoresis on the 3500/3500xL instrument immediately
before loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GeneScan™ 500 ROX™ Size Standard 05 uL
Hi-Di™ Formamide 8.5 L

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.
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Chapter 3 Electrophoresis

Prepare samples for electrophoresis on the 3500/3500xL instrument

e ©® ® N2 o

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

Into each well of a MicroAmp™ Optical 96-Well Reaction Plate, or each
MicroAmp" optical strip tube, add:

* 9 uL of the formamide:size standard mixture
* 1 puL of PCR product or allelic ladder
Note: For blank wells, add 10 puL of Hi-Di"™ Formamide.

Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge to
ensure that the contents of each well are collected at the bottom.

Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95°C.
Immediately put the plate or strip tubes on ice for 3 minutes.

Prepare the plate assembly, then place on the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.
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Section 3.3 310 Instrument

Set up the 310 instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 117 lists the required materials not supplied with the
AmpF(STR™ SGM Plus™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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Electrophoresis The following table lists Data Collection Software and the run modules that can be

software setupand  used to analyze SGM Plus™ Kit PCR products. For details on the procedures, refer
to the documents listed in the table.

reference
documents
Data Operatin
Collection P 9 Run modules and conditions References
System
Software
317 Windows™ XP | e GS STR POP4 (1mL) 310 Genetic Analyzer User’s Manual (Windows]
or or Injection condition: (Pub. no. 4317588
3.0f Windows™ NT 15 kV/5 sec 310 Protocols for Processing AmpF(STR™ PCR
and Amplification Kit Products with Microsoft Windows
Windows™ NT Operating System: User Bulletin
2000 (Pub. no. 4341742)

+ We conducted concordance studies for the SGM Plus™ Kit using this configuration.

Prepare samples for electrophoresis on the 310 instrument

Prepare the samples for electrophoresis on the 310 instrument immediately before
loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GeneScan™ 500 ROX™ Size Standard 0.75 pL
Hi-Di"™ Formamide 24.5 ul

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.
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Prepare samples for electrophoresis on the 310 instrument

2. Pipette the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each 0.2 mL or 0.5 mL sample tube, add:
e 25 uL of the formamide:size standard mixture
¢ 1.5 pL of PCR product or allelic ladder
Note: For blank wells, add 25 uL of Hi-Di"" Formamide.

5. Seal the tubes with the appropriate septa, then briefly centrifuge to ensure that
the contents of each tube are mixed and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95°C.
Immediately place the tubes on ice for 3 minutes.
Place the sample tray on the autosampler.

Ensure that an injection list is prepared.

© ® ® N o

Start the electrophoresis run.
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Section 4.1 GeneMapper™ ID Software

Overview of GeneMapper™ ID Software

GeneMapper " ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each

sample in a .fsa file. Using GeneMapper " ID Software v3.2.1 software, you can then
analyze and interpret the data from the .fsa files.

Instruments Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.
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Set up GeneMapper™ ID Software for data

analysis

Before you start When using GeneMapper'" ID Software v3.2.1 to perform human identification
(HID) analysis with AmpF(STR™ kits, be aware that:

¢ HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.
For multiple ladder samples, the GeneMapper'" ID Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

¢ Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

* Alleles that are not in the AmpF(STR™ Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.

Set up GeneMapper™ ID Software for data analysis

File names The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches &

Updates » GeneMapper' " ID Software.

Workflow Before you can analyze sample (.fsa) files using GeneMapper'" ID Software v3.2.1 for
the first time, you need to:

* Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 35.

* Create an analysis method, as explained in, “Create an analysis method” on page
38.

* Create a size standard, as explained in “Create size standard” on page 43.

¢ Define custom views of analysis tables.
Refer to Chapter 1 of the GeneMapper™ ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub. no. 4335523) for more information.

* Define custom views of plots.
Refer to Chapter 1 of the GeneMapper™ ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (Pub. no. 4335523) for more information.
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Section 4.1 GeneMapper™ ID Software
Set up GeneMapper™ ID Software for data analysis

Import panels and  To import the SGM Plus™ panel and bin set into the GeneMapper'" ID Software
bins v3.2.1 database:

1. Start the GeneMapper " ID Software, then log in with the appropriate user name
and password.

IMPORTANT! If you need logon instructions, refer to page 2-7 of the GeneMapper"™
ID Software Version 3.1 Human Identification Analysis User Guide (Pub. no. 4338775).

2. Select Tools » Panel Manager.

3. Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

(#] Panel Manager
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File Edit Bins Wiew

=) N R M E EiinSet:[

=1 Panel Manaoer

b. Select File » Import Panels to open the Import Panels dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper \ Panels
folder, where x is the drive on which the GeneMapper™" ID Software is
installed.

4. Select AmpFLSTR_Panels_v2.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, AmpFLSTR_Panels_v2. This folder contains the panels and associated

markers.

[#] Import Panels

Laoak in: |BPanels V| I ;’;|E

B [Z] AmpFLETR Bins_v1
4 [E] ampFLSTR Bins_ w2t

Wiy Recent [Z] ampFLSTR_Panelz_v1 txt

Documents B AmpFLSTR_Panels_
?I_-':
Deskiop
‘-;-} File: natne: | AmpFLSTR _Panels_w2 txt | Irrify
My Documents | [ iles Of type: |;ﬂ-.ll Files v | Can
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Set up GeneMapper™ ID Software for data
analysis

5. Import AmpFLSTR_Bins_v2.txt:
a. Select the AmpFLSTR_Panels_v2 folder in the navigation pane.

(#) Panel Manager
File Edit

Bins  View

B3 W M Einset ampFl

= EJPanel Manager
[ ampFLSTR_Panelzs v

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the x:\ Applied Biosystems\ GeneMapper\ Panels
folder.

d. Select AmpFLSTR_Bins_v2.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFLSTR_Panels_v2 folder.

(7] Import Bin Set
Lok ir: |[ﬁ Panels V| I ,3|| =

[Z] AmpFLESTR Bins_w1 txt
L\b’ B AmpFLSTR |

Wiy Recent ] ampFLSTR_Panels_vw1 txt
Documents [Z] ampFLSTR_Panels_v2 txt
?‘[‘:

Desktop

‘_j File: naime: |AmpFLSTR_EIinS_\.f2.t:d |
My Documerts | Files of type: |.ﬂ-.|| Files "| “ancel I

6. View the imported panels in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2 folder.

b. Double-click the SGM_Plus_v2 folder to display the panel information in
the right pane and the markers below it.

\* ! Panel Manager
File Edit Bins View

GE > HEE M e |AmpFLSTR_BinS_v2 v m B wtEm
= EPanel Manager A~ Mirhcer Hame Dye Color | Min Sizme |Max Sizme | Cortrol Alleles Markcer F | Markeer § | Conumemts
[ &mpFLETR_filer_Panel_v2 1 [pastass blue 980 1480 1516 4 041 |nane
|jAmpFLSTR_MiniFiIer_GSSDD_PaneIS_v1 PR hiue 151.0 FE 14,16 4 011 fe—
Si:E::::21;:E:::;:T:S_Panas_w 3 |D165539 blue 2290 2740 9,10 4 013 |none
IjAmpFLSTR_IdentifiIer_PIus_w 4 0251338 blue 2840 3340 20,23 4 015  |none
IjIder‘difilerDired_GSSDD_v1 5 |AMEL green 106.0 114.0 A 9 0.0 none
= EDAMpFLSTR Pariels_v2 & |Des1179 green 1180  [1835  [12413 4 012 |none
Szl:l:e;vj_vz 7 D215 green 1845 2475 283 4 013 |none
mef"er_\,z g D185 green 26449 3500 12,15 4 016  |none
IjProfiIer_PIus_\uQ 9 |D195433 yellow 1010 145.0 1415 4 017 |none
[Tcofier_va 10 |[THO yellow 1590  |2050 |793 4 006 |none
= D38358 11 |FGA yellowe (20625 |360.0 2426 4 o1 nane
R L) | 3
DMES539
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Set up GeneMapper™ ID Software for data analysis

7. View the markers and display the Bin view in the navigation pane:

a. Double-click the AmpFLSTR_Panels_v2 folder to display its list of kits in
the right pane.

b. Double-click the SGM_Plus_v2 folder to display its list of markers below it.

c. Select D8S1179 to display the Bin view for the marker in the right pane.

= [0)
|7/ Panel Manager (‘:D
File Edit Bins ‘iew (0]
BX 0 E o E N e set amprLSTR Bins_v2 o N E W E N (NEEEE . B
= EPanel Manager ~ 8
[ AmpFLSTR_vfiler_Panel_v2 7l sl 8l o) [11) [12) 13 [44) [15] 18] [17] 13 1g] 20 L
[ &mpFLSTR _MiniFiler_GS500_Panels_v1 10 f
[T &mpFLSTR_SEfiler_Plus_Panels_w1 )]
[ &mpFLSTR Panets_v1 [if:] wn
[T &mpFLSTR dertifiler_Plus_v1 %
[idertifilerDirect_GS500_1 08 s
= S &mpFLSTR Panels_v2 o
[ABius_v2 07 (-B
Aerean__v2 ’
CProfiler_vz2 o
CProfiler_Plus_v2 2
Ccofiler vz
B ESSGM_Plus_v2 05
0351355
A, 04
165539
0251335 0.3
02
018551 — 01
0195433
THO1 o0
FGA b M3 19 128 13 137 143 143 155 181 167 173 179 185
=IReference Samples DE51179
< ]
[ Ok ] [ Cancel ] [ Apply ]

8. Click Apply, then OK to add the SGM_Plus_v2 panel and bin set to the
GeneMapper ™" ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels
and bins are not imported into the GeneMapper™" ID Software database.
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Create an analysis  The HID Advanced analysis method for the SGM Plus™ Kit uses the
method AmpFLSTR_Bins_v?2 file described in step 5 on page 36.

Use the following procedure to create a HID analysis method for the SGM Plus™ Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

(7] GeneMapper Manager

Projects |/ | Tahle Settings || Plot Settings | Matrices | Size Standards
Marme Lazt Saved Civyrier Instrument Analysiz 1
IentifilerDirect_HIC_w1 2010-05-05 10:24:1 |gricd HIC:
Identifiler_Plus_Analysizhet | 2011-05-19 14:41:1 |grid HID
Microsatelite Default 2010-01-27 14:58:0 | grnid Microsatel
£

2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.

3. Select HID and click OK to open the Analysis Method Editor with the General
Tab selected.

4. The figures below show the settings for each tab of the Analysis Method Editor.
Configure settings as shown unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

5. After you enter settings in all tabs, click Save.
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General tab : :
. Analysis Method Editor - HID
settings
| General | sliele | Peak Detector | Pesk Qualty | Guality Flags
~&nalysis Method Description
Mame: | SGMPlus_Analysishethod_w1
Description: -~
i (@)
w @
>
(0]
<
Inztrument: %
ie]
@
-‘-4
Analysis Type: HID f
o)
wn
(]
=+
=
)
=
@
l Ok l I Cancel

In the Name field, either type the name as shown, or enter a name of your choosing.
The Description and Instrument fields are optional.
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Allele tab settings

40

Analysis Method Editor - HID

X

General | Peak Detector || Peak Quality | Guality Flags
Bin et |.£\.mpFLSTR_Eiins_v2 v |
Use marker-specific stutter ratio it available
Marker Repesat Type Ti Tetra Perita Hexa
Cut-off Walue oa 0.0 oo oo
Witz Ratio 0.0 [In] [In] [In]
Mirus & Distance From |00 oo [uli} pi]
To 0.0 [In] [In] [In]
Minus Stutter Ratio oa 0.0 oo on
Witz Stutter Distance Frorm oo 325 0.0 0.0
Ta oa 475 oo oo
Pluz Stutter Ratio 0.0 [In] [In] [In]
Pluz Stutter Distance From |00 oo [uli} pi]
To 0.0 [In] [In] [In]
Arnelogenin Cutoff

Range Filter ...

[ Factory Defaults ]

[ [ cmen |

In the Bin Set field, select the AmpFLSTR_Bins_v2 bin set imported previously

and configure the stutter distance parameters as shown.

GeneMapper " ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to

determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for

single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Panels_v2.txt file,
select the “Use marker-specific stutter ratio if available” check box (selected
by default). Perform appropriate internal validation studies to determine the

appropriate filter setting to use.
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Peak Detector tab =
. Analysis Method Editor - HID
settings J tad
General | Allsle | Pesk Detector | peak Quality | Quality Flags
Peak Detection Algarithm: |Advanced R |
Ranges Peak Detection
O Sizing Peak Ampliude Threshalds: .Perforr?
Full Range |.£\.II Sizes b B: | | R: | | lntgrng
" validation
G: | | 0 | }l studies to
determine
¥ I:l settings

—=moathing and Baselining

(8]
=3
7

Min. Peak Half Wicth:

Stnoothing ) Mone
Polynarial Degree: 3

@)
o
=
(0]
<
Q
e
ie]
(0]
i
=<
O
(9]
(]
=1
3
(V)
=
®

() Light
() Heavy Peak Windave Size: 15 pts
Baseline Window: pt= Sy MilEsiele
Peak Start: oo
—Size Calling Method Paak End: 0.0
(:) 2nd Order Least Sguares

() 3rd Order Least Sguares
(:) Cubic Spline Interpolstion
() Local Southern Method
() Global Southern Method

[ Factary Defaults ]

[ox [ comen ]

IMPORTANT! Perform the appropriate internal validation studies to determine
the peak amplitude thresholds for interpretation of SGM Plus™ Kit data.

Fields include:
¢ Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although

GeneMapper " ID Software displays peaks that fall below the specified amplitude
in electropherograms, the software does not label or determine the genotype of

these peaks.

* Size calling method — The SGM Plus™ Kit has been validated using the Local
Southern sizing method. Before using other sizing methods, perform internal

validation studies.
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Peak Quality tab

_ Analysis Method Editor - HID %]
settings _
General | Allele | Pesk Detectar | Pesk Quality | Quslity Flags
Perform
Signal level internal
Homozygous min pesk height \ validation
studies to
Heterozygous min peak height .
va P o determine
Heterozygate balance settings

Wlin peak height ratio

Peak morphalogy

L

Mz peak width (basepairs) 15
Pull-up peak
’7Pull-up ratio 0.0s

Allele number

Max expected aleles

’ Factary Defaults ]

[ [ cmen |

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds and
the minimum peak height ratio threshold for interpretation of SGM Plus"" Kit data.
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Quality Flags tab :
. Analysis Method Editor - HID x]
settings =
General | Allele | Peak Detector | Peak Quality | Qualty Flags |
Quality weight= are between 0 and 1.
—Ewalty Flag Settings
Spectral Pull-up 0.8 Control Concordance 1.0
03 Law Peak Height 03
Broad Peak owy Peak Heig o
Out of Bin Allele Off-scale 08 %
Overlap Peak Height Fatio 03 §
3
@
2
S
%)
o)
=4
PO Thresholds (V)
)
Pass Range: Lovwy Giuality Range:
Sizing Guality: From | 0735 tod1.0 From 0.0 to
Genotype Quality: Fram | 0.75 to1.0 From O0to | 0.25
[ Ok ] [ Cancel ]
IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform the appropriate internal validation studies
to determine the appropriate values for interpretation of SGM Plus'" Kit data.
Create size The GeneScan'" 500 ROX™ Size Standard for the SGM Plus"" Kit uses the following
standard size standard peaks in its definitions: 75, 100, 139, 150, 160, 200, 300, 340, 350, 400, and
450.

Note: The 250-nt peak in the GeneScan"" 500 ROX™ Size Standard is not included in
the size standard definition. This peak can be used as an indicator of precision within a

run.

Use the following procedure to create the appropriate size standard:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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2. Select the Size Standards tab, click New, select the Basic or Advanced radio
button, then click OK.

(7] GeneMapper Manager

| Projects | &nalysis Methods | Table Settings | Plot Settings || Matrices | Size Standards l
Marme Last Saved Crpvrer Type Dezcription
| CE_G5_HID_GS500 201 0-09-08 15.04: 3| gmid Basic/Advanced ‘;J

ey . Open.. Save Lz Export... Delete

3. Enter a name (for example, CE_F_HID_GS500(75-450)). In the Size Standard Dye
field, select Red. In the Size Standard Table, enter the sizes specified in on
page 43. The example below is for the GeneScan'" 500 ROX"" Size Standard.

(#] Size Standard Editor

et

Edit

—=ize Standard Descrigtion

Mame: CE_F_HID_G5500 (75-450) |

Description:

Size Standard Dvyve: Red w

Size Standard Table

Size in Basepairs
1 |750

[

2 |1oo0n

3 1380

4 11500

5 1600

g 2000

¥ |300.0

g |240.0

9 |350.0

10 |400.0

11 (4500

I
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Analyze and edit sample files with GeneMapper™ ID Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings ®

@

Sample Type Select the sample type. CD%
Analysis Method SGMPlus_AnalysisMethod_v1 (or the name of the analysis §
method you created) @

Panel SGM_Plus_v2 s
Size Standard CE_F_HID_GS500(75-450) (or the name of the size standard you %
created) g

Q

1)

t+ The SGM Plus™ Kit was originally validated using the GeneScan™ 500 ROX™ Size Standard. If you use
the GeneScan™ 400 HD Size Standard as an alternative, perform the appropriate internal validation
studies to support the use of this size standard with the SGM Plus™ Kit.

Note: For more information about how the Size Caller works, refer to the
GeneScan"" Analysis Software for the Windows'" NT Operating System Overview of
the Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).

3. Click B (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.
¢ The status bar displays the progress of analysis:
— As a completion bar extending to the right with the percentage
indicated
— With text messages on the left
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* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Genotypes tab becomes available after analysis (see the figure on the

next page).

Project window after analysis

(7] GeneMapper ID v3.2.1 - *Untitled - gmid Is Logged In

File Edit Analysis View Tools Help

e BE NN i B @  Teble Setting  |AmpFLSTR Table v | H BE =

= EProject Samples |

[C]SGM Plus Kit Example Statuz |Sample File Sample Type | Analysis Method Panel Size Stahdard Run Mame
1 !,,q AA15_010_E0S f=a Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_G5_HID_GS500 (75 |SGM Plus Kit Example
2 !,,q AA19_004_B0S fza Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_G5_HID_GS500 (75 |SGM Plus Kit Example
3 !W H4_H25_0_1_001_A07 fza Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_GS_HID_GS500 (75 | SGM Plus Kit Example
4 !W H4_H25_1_0_013_G07 fza Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_GS_HID_GS500 (75 | SGM Plus Kit Example
5 !W H4_H25_1_1_003_B07 f=a Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_GS_HID_GS500 (75 | SGM Plus Kit Example
=1 !W H4_H25_1_2_005_C07 f=a Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_GS_HID_GS500 (75 | SGM Plus Kit Example
7 !W H4_H25_1_3_007_DO7 f=a Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_GS_HID_GS500 (75 | SGM Plus Kit Example
g !W H4_H25_1_5_009_E07 fza Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_GS_HID_GS500 (75 | SGM Plus Kit Example
9 !W H4_H25_1_9_011_FO7 fza Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_GS_HID_GS500 (75 | SGM Plus Kit Example
10 !W H4_H25_aA15_1_1_2_002_A05fsa |Sample SGEMPIus_AnalysisMeth | SGM_Plus_v2 CE_GS_HID_GS500 (75 | SGM Plus Kit Example
ih! !,,q Ladder_012_F035 fza Allelic Ladder | SGMPlus_AnalysisMeth | SGM_Plus_v2 CE_G5_HID_GS500 (75 |SGM Plus Kit Example
12 !,,q MTC_005_D0S5 fza Megative Contre| SGMPIus_AnalysisMeth | SGM_Plus_v2 CE_G5_HID_GS500 (75 |SGM Plus Kit Example
13 !,,q PosttiveControl_006_C05 fsa Posttive Control | SGMPIus_AnalysisMeth | SGM_Plus_v2 CE_G5_HID_GS500 (75 |SGM Plus Kit Example
< ' 3
< | >
IProgress Status ... | 0%

For more information about any of these tasks, refer to the GeneMap

per " ID

Software Version 3.1 Human Identification Analysis User Guide (Pub. no. 4338775).

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).

For more information

For details about GeneMapper™" ID Software features, allele filters, peak
detection algorithms, and project editing, refer to:

* GeneMapper™ ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial
(Pub. no. 4335523)

o GeneMapper™ ID Software Version 3.1 Human Identification Analysis User Guide (Pub.
no. 4338775)

e Installation Procedures and New Features for GeneMapper™ ID Software Software
Version v3.2 User Bulletin (Pub. no. 4352543)
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Overview of GeneMapper™ ID-X Software

Section 4.2 GeneMapper™ ID-X Software

Overview of GeneMapper™ ID-X Software

Instruments

Before you start

48

GeneMapper " ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample

in a .fsa or .hid file. Using GeneMapper " ID-X Software v1.0.1 or higher you can
then analyze and interpret the data from the .fsa or .hid files.

Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.

When using GeneMapperTM ID-X Software v1.0.1 or higher to perform human
identification (HID) analysis with AmpF(STR™" kits, be aware that:

e HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper " ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a
single run.
When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

¢ Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

¢ Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

* Alleles that are not in the AmpF(STR™ Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.
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Set up GeneMapper™ ID-X Software for data analysis

Panel, bin, and The file names shown in this section may differ from the file names you see when you
stutter file version  download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper'" ID-X Software.

The instructions and examples in this section refer to the latest version of panel, bin,
and stutter file available at the time of publication.

Before using the Before you use GeneMapper'" ID-X Software (v1.0.1 or higher for .fsa files, v1.2 or
software for the higher for .hid files) to analyze data for the first time, you must do the following:
first time 1. Check the version of panel, bin, and stutter files installed with the GeneMapperTM

ID-X Software as explained in “Check panel, bin, and stutter file version” below.

®
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=
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=
)

2. Check www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper'" ID-X Software to determine if newer files are
available.

3. If updated files are available, download and import the files into the
GeneMapper ™" ID-X Software, as explained in “Import panels, bins, and marker
stutter” on page 50.

Note: When downloading new versions of analysis files, refer to the associated
Read Me file for details of changes between software file versions. If you have
validated previous file versions for data analysis, conduct the appropriate
internal verification studies before using new file versions for operational
analysis.

4. Create an analysis method, as explained in “Create an analysis method” on page
55.

5. Define custom views of analysis tables.
Refer to Chapter 1 of the GeneMapper™ ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

6. Define custom views of plots.
Refer to Chapter 1 of the GeneMapper™ ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

-_—

Check panel, bin, Start the GeneMapper'" ID-X Software, then log in with the appropriate user
and stutter file name and password.
version

IMPORTANT! For logon instructions, refer to the GeneMapper'" ID-X
Software Version 1.0 Getting Started Guide (Pub. no. 4375574).

2. Select Tools » Panel Manager.

AmpFtSTR™ SGM Plus™ PCR Amplification Kit User Guide 49


www.lifetechnologies.com/support
www.lifetechnologies.com/support

4 Chapter 4 GeneMapper™ |ID-X Software
Set up GeneMapper™ ID-X Software for data analysis

3. Check the version of files imported into the Panel Manager:

[#] Panel Manager
File Edit Bins Wiew

a. Select Panel Manager in the navigation pane.

b. Expand the Panel Manager folder and any sub-
folders to identify the analysis file version already
installed for your kit choice.

4. Check the version of files available for import into the
Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Panels folder and check the version of panel, bin,
and stutter files installed.

5. If newer versions are available on the website, download and import as described
below.

Import panels, To import the SGM Plus™ Kit panel, bin set, and marker stutter from our web site
bins, and marker into the GeneMapper'" ID-X Software database:

stutter 1. Download and open the file containing panels, bins, and marker stutter:

a. Go to www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper'" ID-X Software. Download the file AmpFLSTR
Analysis Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper " ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper™ ID-X
Software Version 1.0 Getting Started Guide (Pub. no. 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

[#) Panel Manager
File Edit Bins View

£F I

== Panel Manager

b. Select File » Import Panels to open the Import

Panels dialog box.
W |

X
c. Navigate to, then open the AmpFLSTR Analysis .

Files GMIDX folder that you unzipped in step 1
on page 50.
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5. Select AmpFLSTR_Panels_v2X (or the version you installed), then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager “AmpFLSTR_Panels_v2X”. This folder contains panels for multiple

AmpF(STR™ kits and associated markers.

« Import Panels ®
Lookin: EAmpFLSTR Analysis Files GMIDK V| 53 ,_‘?'||EI

Y L] AmpFLSTR_Bins_vzx
o 8

My Recent EIA - .
Documents | ] Reade_AmpFLSTR vz

Desktop

My Documents

(@)
)
=]
@
<
D
©
o
@
2
S
x
n
o
=
£
)
=
@

g’ Flename:  |AmpFLSTR_Panels_vZi.bxt | [ mport |

My Computer | Files of bype: |,q|| Files v| Cancel

6. Import AmpFLSTR_Bins_v2X.txt:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation pane.

« Panel Manager,
File Edit Bins View Help

WX (W E M W® |ense:|ampriseens_ v | i B B B EH BDEEEEEE

B...d%‘pand Manager Panel Hame Commment

[ AMpFLSTR_MGMSElect_vzy 1 [Cofler_wl.1x rull &

: gAmDFLSTR—NGM—VSX 2 |SEM_Plos_w1.1% il

AMpFLSTR_Panels_w1x

= = MGM_SElect_vz.1% Il

[ AmpFLS TR, Panels_vzy] 3 i n

4 |Identifiler_Plus_w1.1% rll

S |MGEM_v3.1% rll

& | Identifiler_Direct_w1.1%  |null

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
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d. Select AmpFLSTR_Bins_v2X.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFLSTR_Panels_v2X folder.

« Import Bin Set ®
Lok in; E AMpFLSTR. Analysis Files GMIDR v | 5 ,,’:"|| =

i) AmpFLSTR Bins_vex |
L] ArmpFLSTR Panels_vzx
My Recenk QI AmpFLSTR_Stutker_wZx
Locuments | P ReadMe_AmpFLSTR_w2X

8 jie

Desktop

@

My Documents

File name: |&mpFLSTR_Bins_v2X.bxt | [ import |

My Computer | Files of bype: |p||| Files v| Cancel

7. View the imported panels in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2X folder.

b. Double-click the SGM_Plus_v1.1X folder to display the panel information in
the right pane.

» Panel Manager
File Edit Bins ‘Wiew Help

' X O H O W™ enset:|amprstrEns_.. v | lii Ty Il B H HEBER

IE

=R d%b Panel Manager Pael Hame Commert.
L [CAMPFLSTR _MEMSElect_vas 1 Ofiler_wl,1% ndll
(CDAmpFLSTR_NGM 33 2 |SGM_Plus_v1.1% nul
E}“B.ﬂ.mpFLSTR_Panels_vl 3 |NGM_SElect_wz, 1% ndll
4 |Idenkifiler _Plus_v1.1% ndll
---[ESGM_F‘EIS_N JAX S |NGEM_w3 1X ndll
£ [OMGM_SElect_v2. 1% & |Idertifiler_Direct_w1.1% |null
g Ldgh:T:rl_ : lus vl 1% 7 |Profiler_Plus_v1.1X null
- 1dentifiler_Direct_v1.1% 5 |Profiler_v1.1% nul
[ﬁ Profiler_Phus_w1.1% a | SEfiler_Phus_w1.1% rdll
& DProfiler 1.1 10 |Tdenkifiler_vi. 1% nul
gfgg:ﬁ}ﬁzﬁ‘ﬂ;x 11 |MiniFiler_v1. 13 nul
---EMiniFiler_vl 1w 12 |Profiler_Plus_CODIS_wi. 1 {null
W T Prefiler Plie CODTS Wi 1Y 12 IwFiler w1 1% ruill
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8. Select and expand SGM_Plus_v1.1X in the navigation pane, then select D851179

to display the Bin view for the marker in the right pane.

#* Panel Manager E|
File Edit Bins View Help

B> | 5 B W | OB WY | Einset |AmpFLSTR_Bins_v2><

ViLEeE SEEEEEEE 9

B---%Panel Manager ~
;—----@AmpFLSTR_PaneIs_vl>< . 7 ] 9 10 11 120 13 14 18 18 17 |18 13| 20
= AMpFLS TR _Panels_v2 o
t- [T Profiler_v1.1% 0.4 g
. (0]
@Prof.ller_Plus_vl B s g
-2 COfiler vl 13 <
. 07 z
°
06 @
2
0.5 %
P
0.4
>
03 w
| =S
0.2 QE)
0.1 =
(0]
-IC Identifiler _v1. 1% 0.0
B[ SEFiler_Plus_v1.1x 112115 117 119121 123125 127 123131 133135 137 139141 143145 147 149151 153155 157 159 161 163165 167 169171 173175 177179 181 183185 187
_— Al Ol T 11 M
------ i Reference Samples DE51179
< =
[ OF ] [ Cancel ] [ Apply ] [ Help ]

9. Import AmpFLSTR_Stutter_v2X:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation panel.

« Panel Manager
File Edit Bins Yiew Help

X O EF M M ™ | inses |amprisTR Bns_ (v [ Il Ty I B B

=
= &Panel Manager Panel Hame Convment
[CAmpFLSTR_MGMSEleck w2y 1 Ofiler w1, 1% null =
(D AMpFLSTR_NGM_v3X 2 |SGM_Plus_wl.1% null
S-le 3 |NGM_SElect_wz.1% nul
4 |Identifiler_Plus_wi.1% null

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog

box.

c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
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d. Select AmpFLSTR_Stutter_v2X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the AmpFLSTR_Panels_v2X folder.

« Import Marker, Stutter ®
Look in: E AmpFLSTR. Analysis Filss GMIDH v | 5 ,:J|| =

E L AmpFLSTR_Bins _ves

L AmpFLSTR_Panels_va
My Recent B AmpFLSTR_Stutte
Locuments | ] ReadMe_AmpFLSTR_w2X

Desktop
o

My Documents

73])3 File name: |AmpFLSTR_Stutter_v2:.txt | [ mport |
My Compuker | Files of bype: |.0.II Files v| Cancel

10. View the imported marker stutters in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2X folder to display its list of kits in
the right pane.

b. Double-click the SGM_Plus_v1.1X folder to display its list of markers below
it.

c. Double-click D21511 to display the Stutter Ratio & Distance view for the
marker in the right pane.

#* Panel Manager le
File Edit Bins View Help
A 5 B W B ™ Binset: |AmpFLSTR Bins_vaX V| W E BEEEEENE o

i -~
Bgﬁﬂﬁitglﬁ:ﬁ:g:{zjg 3 Please enter the stutter filter(s) for D215 11 marker here If left blank, the global stutter filter will be
o[ Profiler_v1.1% applied.

[C)Profiler_Plus_v1.1%
[ Cofiler 1,13 .

SGM,_Pius_v1. 1% Minus Stutter Plus Stutter
D351358 Ratio From Distance To Distance Ratio From Distance To Distance
A 1500 3.5 475
D165533
0251333
AMEL
0851179
021511
Stutker Ratio & Distance
+- 015551 [ Mew ] [ Edit ] [ Delete ]
(- D195433
[ THOL
- FGA v

o] =
o] =

11. Click Apply, then OK to add the SGM Plus ™ Kit panel, bin set, and marker stutter
to the GeneMapper'" ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter will not be imported into the GeneMapper
ID-X Software database.
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Create an analysis  Use the following procedure to create an analysis method for the SGM Plus™ Kit.
method

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created
for GeneMapper ' ID-X version 1.2 is not compatible with earlier versions of
GeneMapper " ID-X Software or with GeneMapper'" ID Software version 3.2.1.

1. Select Tools » GeneMapper'" ID-X Manager to open the
GeneMapper " ID-X Manager.

 GeneMapper® ID-X Manager (%]

Find Mame Conkaining:

(@)
)
=]
@
<
D
©
o
@
2
S
x
n
o
=
£
)
=
@

Projects | Analysis Methods | Table Settings || Plaot Settings || Matrices | Size Standards | Report Settings

[ Mew... ][ Open... ][ Save As... ][ Import... ][ Export,..

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.
The figures below show the settings for each tab of the Analysis Method Editor.
Configure the Analysis Method Editor tab settings as shown in the figures below,
unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

3. After you enter settings in all tabs, click Save.
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General tab

settings Analysis Method Editor 3]
General | llele | Pesk Detertor | Peak Quality | 5Q & Gy Settings |
rAnalysis Method Descripkion
Marie: |SGMPIus_P.naIysisMethnd_vIX |
Security Group: |GeneMapper ID-= Security Group w |
Description: =)
v
Instrument: ||
Analysis Type: HID
l Save l l Cancel l l Help l

In the Name field, either type the name as shown or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software
configuration from the dropdown list. The Description and Instrument fields are

optional.
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Allele tab settings :
g Analysis Method Editor E|

| General | Allele | Peak Detector | Peak Quality | 55 & G0 Settings |

Bin Set: nn-.pFLETF:__E:ins

Use marker-specific stutter ratio and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Value 0.0 0.0 0.0 0.0
Minus4 R.atio 0.0 0.0 0.0 0.0
Minusa Distance From 0.0 0.0 0.0 0.0
To |0.0 0.0 0.0 0.0
Global Minus Stutker Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From (0.0 3.25 0.0 0.0
To (0.0 4.75 0.0 0.0
Global Plus Skukter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Distance From (0.0 0.0 0.0 0.0
To |0.0 0.0 0.0 0.0
Amelogenin Cukoff

Range Filter. .. Factory Defaulks

l Save ” Cancel ” Help l

¢ In the Bin Set field, select the AmpFLSTR_Bins_v2X bin set and configure the
stutter distance parameters as shown.

e GeneMapper " ID-X Software v1.0.1 or higher allows you to specify 4 types of
marker repeat motifs: tri, tetra, penta and hexa. You can enter parameter values
for each type of repeat in the appropriate column.

* Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Stutter_v2X file,
select the “Use marker-specific stutter ratio if available” check box (selected
by default). Perform appropriate internal validation studies to determine the
appropriate filter setting to use.
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Pea!( Detector tab Analysis Method Editor, ]
settings

General | Allele Peak Quality | 50 & GQ Settings

Peak, Detection Algorithm: advanced

Ranges Peak Detection
: - Perform
Analysis Sizing Peak Amplitude Thresholds: internal
Full Range All Sizes w . i K .
B: R: validation
G 0 studies to
determine
\ settings
Smoothing and Baselining 9
Min. Peak Half width: | 2 pis
Smoathing () Mane
i g )
@) Light Palynomial Degree:
() Heavy Peak Window Size: 15 pts
Baseline Window: 51 pts Slape Threshold
Peak Stark: 0.0
rSize Calling Method P, -

() 2nd Order Least Squares
() 3rd Order Least Squares
() Cubic Spling Interpolation
(#) Local Southern Method
() Global Southern Method

Factary Defaults

Save As ” Save ” Cancel ” Help l

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of SGM Plus™ Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper " ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the
genotype of these peaks.

* Size calling method — The SGM Plus™ Kit has been validated using the Local
Southern sizing method. Before using other sizing methods, perform internal
validation studies.

¢ Normalization — A Normalization checkbox is available on this tab in

GeneMapper " ID-X Software v1.2 for use in conjunction with data run on the
Applied Biosystems 3500 Series Genetic Analyzers. Normalization cannot be

applied to 4-dye data, so this feature is not for use with SGM Plus"" Kit data.
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Peak Quality tab

. Analysis Method Editor
settings d

General | Alele PeakDetectan

3]

ﬂnIMax Peak Height (LPHIMPH) \

Homozygous min peak. height

Heterozygous min peak height

MMax Peak Height (MPH)

Peak. Height Ratio (PHR)

L

.

Qﬂ peak height: ratio

Broad Peak (BDY

—
o

Max peak width (basepairs)

Allele Mumber (AR

Max expected alleles

I

Allelic Ladder Spike
Cut-off Yalue 0.z

[ Factory Defaults

[ Save H Cancel H Help ]

Perform
internal
validation
studies to
determine
settings

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds,
maximum peak height threshold and the minimum peak height ratio threshold

for interpretation of SGM Plus'" Kit data.
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SQ & GQ tab
settings

Create size
standard (optional)

60

Analysis Method Editor (%)

Cuality weights are between 0 and 1,
rSample and Control GO Weighting

Broad Peak (BL) 0.5 Allele Mumber (AR 1.0
Dot of Bin Allele (BIN) 0.5 Low Peak Height (LPH) 0.3
Crverlap (OVL) 0.8 Max Peak Height: (MPH) 0.3
Marker Spike (SPK) 0.3 Off-scale (05) 0.8

Peak. Height Ratio (PHR) 0.3

Contral Concordance (ZC) Weight = 1.0 (Only applicable ko contrals)

30 weighting
Broad Peak (BD)

rallelic Ladder G0 weighting
Spike (SSPKJSPE) Off-scale (03)

S0 & G0 Ranges

Sizing Ciuality: From | 0.75 to 1.0 FromO.0ko | 025

Genobype Guality:  From | 0.73 to 1.0 FromO.0ko | 025

Reset Defaulks

I
i
h=]

[ Save As ][ Save ][ Cancel ]

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to
determine the appropriate values to use.

The CE_F_HID_GS500 (75-450) size standard definition is installed with the software
for use with the SGM Plus™ Kit and contains the following size standard peaks:

GeneScan™ 500 ROX™ Size Standard
75, 100, 139, 150, 160, 200, 300, 340, 350, 400, and 450

Note: The 250-nt peak in the GeneScan'" 500 ROX™" Size Standard is not included in
the size standard definition. This peak can be used as an indicator of precision within a
run.

Use the following procedure if you want to create your own size standard:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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2. Select the Size Standards tab, then click New.

Find Mame Containing:

| Projects | Analysis Methods | Table Settings | Plat Settings | Matrices| Size Standards | Repart Settings |

Marne Last Saved Cwner Type Description
| CE_F_HID_GS500 (75-400) 2007-05-09 13:23:5 | gmidx Advanced
| CE_F_HID_G5500 (75-450) 2007-05-09 13:24:0 | gmidx Advanced
| CE_G5_HID_GS500 2006-10-11 13:12:% | gmids Advanced
| GS600_LIZ 2007-06-26 10:43:1|grid:x Advanced
| GS600_LIZ+Mormalization_{80-400% |2007-06-27 01:43:1|gmid:x Advanced
| ES600_LIZ_(R0-400) 2007-06-27 01:43:1|gmidx Advanced

e Qpen... Save As... Irnpork. .. Expork. .. Delete
[ tew... ]
Help Done

3. Enter a name. In the Size Standard Dye field, select Red. In the Size Standard
Table, enter the sizes specified in on page 60. The example below is for the
GeneScan'" 500 ROX™ Size Standard.

(@)
)
=]
@
<
D
©
o
@
2
S
x
n
o
=
£
)
=
@

®

« Size Standard Editor
Edit

Size Standard Description
Mame: CE_F_SGEMPlus_z5500

Security Group: GeneMapper ID-k Security Group W

Description:

Size Standard Dye: Red w |

rSize Standard Table
Size in Basepairs
o Insert: Delete

z |100.0

|

3 [139.0

4 |150.0 =

5 |160.0

6 |200.0

7 |340.0

& |[350.0

9 [400.0

10 (450.0

»

[ OF H Cancel H Help ]
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Analyze and edit sample files with GeneMapper™ ID-X Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method SGMPlus_AnalysisMethod_v1X (or the name of the analysis
method you created)
Panel SGM_Plus_v1.1X
Size Standard CE_F_GS500(75-450) (or the name of the size standard you
created)

t+ The SGM Plus™ Kit was originally validated using the GeneScan™ 500 ROX™ Size Standard. If you use
the GeneScan™ 400 HD Size Standard as an alternative, perform the appropriate internal validation
studies to support the use of this size standard with the SGM Plus™ Kit.

Note: For more information about how the Size Caller works, refer to the
GeneScan"" Analysis Software for the Windows'" NT Operating System Overview of
the Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).
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Examine and edit a project

3. Click ™ (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

* The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed and the Genotypes tab becomes
available upon completion of the analysis.

Analysis summary window after analysis

» GeneMapper® ID-X - SGM Plus Kit Example Project - gmidx Is Logged In Database GEOLDROYNJOSE
File Edit Analysis View Tools Admin Help

Ci ﬁ % @ E 1l ﬁ [ 3 ﬁ Table Setting: |31XX Daka Analysis v| )O =1 @ B @
B---ﬁﬁpfﬂjﬁt Y Gamples | Analysis Summary | Genat

Analysis Summary

(@)
)
=]
@
<
D
©
o
@
2
S
x
n
o
=
£
)
=
@

Select run Folder ta display:

Sample Skatus [ Total # of Samples ]
[@ Unanalyzed o
Analyzed 13
l@ Analysis Setting Changed o

Click a link below to display a filtered Samples Table containing only the samples selected
Allelic Ladder Quality per run folder (based on $Q and CGQ only)

Run Folder ][ Tokal # of Analyzed Ladders ][ ][ F'y ][ E
5GM Plus Kit Example | L | ¢+ | o | o |

Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SQ, CGQ)

Contral Type [ Tokal # of Samples [ Al threshalds met [ O One or more thresholds nat met
Positive Control 1 1 o
Cusbom Control 0 0 0
Megative Control 1 1 o
Tatal z z 0
Sample Quality per project (based on sample POVs: SOS, SSPK, MIX, OMR, SQ, CGQ)
[ Total # of Samples [ All thresholds met [ O One of more thresholds not met ]
Samples 10 1 9 | B

Analysis Completed. I

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).
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For more information

For more information

For more information, refer to:

o GeneMapper™ ID-X Software Version 1.0 Getting Started Guide (Pub. no. 4375574)

e GeneMapper"' ID-X Software Version 1.0 Quick Reference Guide (Pub. no.
4375670)

o GeneMapper™ ID-X Software Version 1.0 Reference Guide (Pub. no. 4375671)

» GeneMapper"' ID-X Software Version 1.1(Mixture Analysis) Getting Started Guide
(Pub. no. 4396773)

»  GeneMapper" ID-X Software Version 1.2 Reference Guide (Pub. no. 4426481)

» GeneMapper™ ID-X Software Version 1.2 Quick Reference Guide (Pub. no.
4426482)

64 AmpFISTR™ SGM Plus™ PCR Amplification Kit User Guide



Experiments and Results

B Section 5.1 Developmental Validation ........................... ... ... 66
OVeIVIEW . . 66
Developmental validation............... ... . ... ... ... i 66
Accuracy, reproducibility, and precision. ............ oo 67
Extra peaks in the electropherogram. ............... ... ..., 74
Characterization of Ioci .. ..... ... i 82
Species specificity . . ... ... 83
Sensitivity ..... ... 85
Stability ... ... 86
Populationdata.......... .. ... 92
Mutationrate. ... ... 99
Probability of identity ............ ... ... o 100
Probability of paternity exclusion ........... ... ... 100

B Section 5.2 Performance Validation After Buffer and Enzyme Component
Replacement .......... .o i 102
OVeIVIEW . . e 102
Experiments. .......... ... 102
Reproducibility study ........ ... ... 103
Sensitivity study ... ... 106
Inhibitionstudy ....... ... ... ... 108
CONCIUSIONS .+« v vt 112

AmpFtSTR™ SGM Plus™ PCR Amplification Kit User Guide 65



Chapter 5 Experiments and Results

Overview

Section 5.1 Developmental Validation

Overview

Importance of
validation

Experiment
conditions

This section provides results of the developmental validation experiments we
performed using the SGM Plus'" Kit.

These studies meet and exceed those recommended in the Technical Working Group
on DNA Analysis Methods (TWGDAM) guidelines as well as the DNA Advisory
Board (DAB) Quality Assurance Standards, effective October 1, 1998 (Technical
Working Group on DNA Analysis Methods, 1995; DNA Advisory Board, Federal
Bureau of Investigation, U.S. Department of Justice, 1998). These studies also address
the guidelines outlined in the ENFSI DNA Working Group Quality Assurance
Programme for DNA Laboratories.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations
which are critical for sound data interpretation in casework (Sparkes, Kimpton,
Watson et al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin ef al., 1998).

This chapter discusses many of the experiments we performed and provides examples
of results obtained. We chose conditions that produced optimum PCR product yield
and that met reproducible performance standards. It is our opinion that while these
experiments are not exhaustive, they are appropriate for a manufacturer of STR kits
intended for forensic and/or parentage testing use. Each laboratory using the SGM
Plus™ Kit should perform their own internal validation studies.

Developmental validation

DAB 8.1.1
Developmental
Validation

PCR components

66

“Developmental validation that is conducted shall be appropriately documented.” (DNA
Advisory Board, 1998).

Critical reagent concentrations and reaction conditions (such as thermal cycling
parameters, AmpliTaq Gold"" DNA polymerase activation, cycle number) to produce
reliable, locus-specific amplification and appropriate sensitivity have been
determined.

The concentration of each component of the SGM Plus ' Kit was examined. The PCR
components are Tris-HCI (pH 8.3), KCI, dNTPs, primers, AmpliTaq Gold DNA
Polymerase, MgCl,, bovine serum albumin, and sodium azide. The concentration for a
particular component was established to be in the window that meets the reproducible
performance characteristics of specificity and sensitivity.
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Thermal cycler
parameters

AmpliTaq Gold™
DNA Polymerase
activation

Section 5.1 Developmental Validation

Accuracy, reproducibility, and precision

After the optimal concentration was determined for a single component, the others
were tested sequentially until it was determined that each component was at the
optimal concentration relative to the concentrations of the other components in the
master mix. The optimized SGM Plus™ Kit provides the required degree of specificity
such that it is specific to primates for the species tested (with the exception of the
amelogenin locus, see “Nonhuman studies” on page 84) and does not produce
nonspecific mispriming artifacts.

Thermal cycling parameters were established for amplification of the SGM Plus'" Kit
in the DNA Thermal Cycler 480 and GeneAmp' " PCR Systems 2400, 9600, and 9700.
Thermal cycling times and temperatures met GeneAmp' " PCR Instrument
specifications. Annealing and denaturation temperature windows were tested around
each setpoint to verify that a +2°C window (DNA Thermal Cycler 480) or +1.5°C
window (GeneAmp PCR System 2400, 9600, and 9700) yielded specific PCR product
with the desired sensitivity of at least 1 ng of AmpF(STR™ Control DNA 007.

SGM Plus™ Kit reactions were amplified for 27, 28, 29, 30, and 31 cycles on the
GeneAmp PCR System 9600 using 1.5 ng of three DNA samples. As expected, PCR
product increased with the number of cycles. Peak heights for all loci were above 150
RFU, even at 27 cycles; off-scale data was collected for several allele peaks at 31 cycles.
See “DNA quantification” on page 19 for information on off-scale data.

While none of the cycle numbers tested produced nonspecific peaks, 28 cycles was
found to give optimal sensitivity when the amplified products were examined on
Applied Biosystems instruments. Additionally, the cycle number was set to avoid
detection of low quantities of DNA (35 pg or less). At 28 cycles, 2.0 ng of AmpF(STR™
Control DNA 007 amplifies reliably and specifically following the conditions outlined
in this manual.

The thermal cycler program for the SGM Plus ™ Kit includes an initial incubation to
allow for AmpliTaq Gold™ DNA polymerase activation. Polymerase activation times
and temperatures were tested in the DNA Thermal Cycler 480 and the GeneAmp PCR
Systems 2400, 9600, and 9700.

Five activation times (5, 8, 11, 14 and 17 minutes) were tested. A plateau in
fluorescent signal (RFU) of the SGM Plus"™ Kit loci was reached at ~8 minutes and
was maintained through the 17-minute timepoint. The 11-minute activation time was
determined to be optimal based on this plateau (within a + >25% window).

A 95°C activation temperature (for 11 minutes) was determined to be optimal for the
reactions. These conditions produced maximum PCR product yield and a window in
which reproducible performance characteristics were met.

Accuracy, reproducibility, and precision

DAB 8.1.2 Accuracy

“Novel forensic DNA methodologies shall undergo developmental validation to ensure the
accuracy, precision and reproducibility of the procedure.” (DAB, 1998).

Laser-induced fluorescence detection systems of length polymorphism at short
tandem repeat loci is not a novel methodology (Holt et al., 2001 and Wallin et al.,

2001). However, accuracy and reproducibility of SGM Plus™ Kit profiles have been
determined from various sample types.
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Chapter 5 Experiments and Results

Accuracy, reproducibility, and precision

Accuracy

Reproducibility

68

Figure 5 illustrates the size differences that are typically observed between sample
alleles and AmpF(STR™ SGM Plus™ Allelic Ladder alleles on the Applied Biosystems
310 Genetic Analyzer with POP-4™ polymer. The x-axis in Figure 5 represents the
nominal base pair sizes for a single injection of AmpF(STR™ SGM Plus'™ Allelic
Ladder, and the dashed lines parallel to the x-axis represent the +0.5-bp windows. The
y-axis is the deviation of each sample allele size from the corresponding allelic ladder
allele size. The data include a total of 892 alleles from 30 population database samples
and two injections of allelic ladder. In this representative example, all sample alleles
are within 0.5 bp of a corresponding allelic ladder allele.

Figure 5 Size deviation of 30 samples and two allelic ladders from one injection of allelic ladder
on a single Applied Biosystems 310 instrument run.
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The AmpF(STR™ SGM Plus™ Allelic Ladder contains the majority of alleles for the
D351358, vWA, D165539, D251338, amelogenin, D851179, D21511, D18551, D195433,
THO1, and FGA loci. However, alleles not found in the AmpF(STR™ SGM Plus™
Allelic Ladder do exist. These “off-ladder” alleles may contain full and/or partial
repeat units. An “off-ladder” allele should flag itself by not falling inside the +0.5 bp
window of any known allelic ladder allele.

Note: If a sample allele peak is found to be >0.5 bp from the corresponding allelic
ladder peak, then the sample must be rerun to verify the result.

The reproducible nature of purified DNA samples from various individuals (>10),
used routinely at Life Technologies, as well as validation samples processed during
characterization of AmpF/(STR™ PCR Amplification Kits (for example, from body
fluid mixture studies, environmental studies, matrix studies, nonprobative studies,
CEPH family DNA sets) was without exception. All samples yielded the correct

genotype.
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windows

Section 5.1 Developmental Validation

Accuracy, reproducibility, and precision

As indicated in the previous section, the recommended method for genotyping is to
employ a +0.5-bp “window” around the size obtained for each allele in the
AmpF(STR™ SGM Plus™ Allelic Ladder. A +0.5-bp window allows for the detection
and correct assignment of potential off-ladder sample alleles whose true size is only
one base different from an allelic ladder allele. Alleles of all possible sizes (within the
range of 75-400 bp) should be readily identifiable. Any sample allele that sizes outside
a window could be either of the following:

* An “off-ladder” allele, i.e., an allele of a size that is not represented in the

AmpF(STR™ SGM Plus™ Allelic Ladder (go to http://www.cstl.nist.gov/
strbase/for examples of known off-ladder alleles)

* An allele that does correspond to an allelic ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections in one capillary run.

Table 3 on page 70 indicates typical precision results obtained from 30 database
samples and three AmpF(STR"™ SGM Plus' Allelic Ladder samples analyzed on the
Applied Biosystems 310 Genetic Analyzer (47-cm capillary, POP-4"" polymer,
GeneScan'" 500 ROX"" Size Standard). These results were obtained within a set of
injections on a single capillary.

As indicated above, sample alleles may occasionally size outside of the +0.5-bp
window for a respective allelic ladder allele because of measurement error. The
frequency of such an occurrence is lowest in detection systems with the smallest
standard deviations in sizing. Figure 5 on page 68 illustrates the tight clustering of
allele sizes obtained on the Applied Biosystems 310 Genetic Analyzer, where the
standard deviation in sizing is typically less than 0.15 bp. The instance of a sample
allele sizing outside of the +0.5-bp window because of measurement error is relatively
rare when the standard deviation in sizing is approximately 0.15 bp or less (Smith,
1995).

For sample alleles that do not size within a +0.5-bp window, the PCR product must be
rerun to distinguish between a true off-ladder allele versus measurement error of a
sample allele that corresponds with an allele in the allelic ladder.

It is important to note that while the precision within a set of capillary injections is very
good, the determined allele sizes vary between platforms. Cross-platform sizing
differences arise from a number of conditions, including type and concentration of
polymer, run temperature, and electrophoresis conditions. Variations in sizing can also
be found between runs on the same instrument and between runs on different
instruments because of these conditions. We strongly recommend that the allele sizes
obtained be compared to the sizes obtained for known alleles in the AmpF(STR™
SGM Plus™ Allelic Ladder from the same run and then converted to genotypes (see
“Allelic ladder requirements” on page 25). For more information on precision and
genotyping, see Lazaruk et al., 1998.
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Chapter 5 Experiments and Results

Accuracy, reproducibility, and precision

Table 3 Example of precision results on the Applied Biosystems Genetic Analyzer

Allele n Mean S.D.
D351358
12 3 111.25 0.02
13 4 115.38 0.01
14 8 119.36 0.03
15 ' 17 123.35 ' 0.10
15 10 127.48 0.09
17 16 131.58 0.07
18 10 135.78 0.09
19 ' 5 139.92 ' 0.08
VWA
1 3 154.59 0.04
12 3 158.80 0.01
13 ' 3 163.00 ' 0.02
14 1 167.22 0.1
15 7 171.18 0.05
16 13 175.15 0.07
17 ' 12 179.18 ' 0.06
18 16 183.15 0.06
19 9 187.09 0.07
20 3 190.94 0.04
21 3 194.88 ' 0.05
22 3 198.73 0.06
23 3 202.55 0.06
24 3 206.83 0.04
D165539
5 3 229.29 0.06
8 4 241.27 0.01
9 8 245.25 0.08
10 6 249.33 ' 0.07
11 19 253.27 0.07
12 22 257.31 0.06
13 12 261.36 0.07
14 ' 3 265.51 ' 0.04
15 3 269.57 0.03
D251338
15 4 290.55 0.03
16 ' 4 294.67 ' 0.02
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Allele n Mean S.D.
17 11 298.75 0.06
18 8 303.12 0.07
19 1" 307.53 0.07
20 10 311.86 0.10
21 4 316.20 0.05
22 7 320.39 0.12
23 9 324.68 0.15
24 " 328.72 0.09
25 10 332.93 0.1
26 4 336.92 0.12
27 3 340.89 0.06
28 3 344.57 0.08

Amelogenin
29 103.48 0.06
18 109.13 0.07
D8S1179
8 3 123.69 0.02
9 6 127.73 0.03
10 7 131.80 0.08
" 6 135.92 0.40
12 9 140.20 0.06
13 19 144.72 0.10
14 14 149.23 0.10
15 14 153.70 0.07
16 3 158.08 0.02
17 3 162.27 0.06
18 3 166.38 0.04
19 3 170.48 0.04
D21S11
24 3 185.21 0.03
24.2 3 187.21 0.04
25 3 189.17 0.03
26 3 193.08 0.05
27 3 197.01 0.06
28 " 200.82 0.07
28.2 3 202.78 0.06
29 12 204.77 0.05
29.2 3 206.71 0.04
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5 Chapter 5 Experiments and Results
Accuracy, reproducibility, and precision

Allele n Mean S.D.
30 21 208.74 0.07
30.2 4 210.67 ' 0.08
31 7 212.68 0.04
31.2 7 214.61 0.07
32 5 216.67 0.03
32.2 5 218.57 0.06
33 4 220.58 ' 0.07
33.2 7 222.53 0.05
34 3 224.55 0.04
34.2 5 226.53 0.04
35 3 228.54 ' 0.04
35.2 3 230.47 0.05
36 3 232.56 0.04
37 3 236.51 0.03
38 3 240.43 0.02
D18S51

7 3 262.31 0.04
9 3 270.55 0.01
10 4 274.64 ' 0.07
10.2 3 276.67 0.04
1 4 278.77 0.03
12 9 282.88 0.08
13 12 286.98 ' 0.05
13.2 3 289.03 0.03
14 15 291.13 0.06
14.2 3 293.22 0.03
15 7 295.31 ' 0.03
16 13 299.46 0.06
17 9 303.94 0.08
18 4 308.38 0.08
19 6 312.77 ' 0.12
20 3 317.11 0.13
21 4 321.35 0.09
22 3 325.58 0.13
23 3 329.78 ' 0.17
24 3 333.95 0.13
25 3 338.05 0.09
26 3 341.93 0.15
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Allele n Mean S.D.
27 3 345.59 0.10
D19S433
9 3 102.01 0.05
10 3 105.93 0.04
1M 3 109.82 0.07
12 6 113.68 0.06
12.2 3 115.73 0.04
13 16 117.62 0.04
13.2 4 119.65 0.06
14 22 121.57 0.08
14.2 6 123.60 0.07
15 14 125.54 0.06
15.2 5 127.62 0.06
16 7 129.54 0.08
16.2 3 131.59 0.06
17 3 133.60 0.05
17.2 3 135.62 0.03
THO1
4 3 163.12 0.01
5 3 167.19 0.05
6 16 171.20 0.06
7 7 175.25 0.04
8 7 179.25 0.09
9 14 183.23 0.08
9.3 22 186.26 0.05
10 3 187.21 0.04
" 3 191.13 0.03
13.3 3 201.87 0.06
FGA
17 3 212.48 0.02
18 5 216.51 0.07
19 7 220.52 0.06
20 10 224.54 0.06
21 16 228.52 0.07
22 14 232.60 0.07
23 12 236.62 0.03
24 8 240.64 0.07
25 8 24474 0.06
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Chapter 5 Experiments and Results

Extra peaks in the electropherogram

Allele n Mean S.D.
26 3 248.78 0.04
26.2 3 250.83 0.03
27 3 252.77 0.02
28 3 256.89 0.01
29 3 260.99 0.06
30 3 265.10 0.05
30.2 3 266.95 0.05
31.2 3 271.05 0.03
32.2 3 275.17 0.05
33.2 3 279.27 0.03
42.2 3 317.77 0.13
43.2 3 322.01 0.11
44.2 3 326.21 0.10
45.2 3 330.39 0.10
46.2 3 334.44 0.10
47.2 3 338.55 0.08
48.2 3 342.41 0.04
50.2 3 349.77 0.00
51.2 3 353.44 0.04

Extra peaks in the electropherogram

Overview

Stutter products

74

Peaks other than the target alleles may be detected on the electropherogram displays.
Described below are several causes for the appearance of extra peaks, including the
stutter product (found at the n—4 position), incomplete 3" A nucleotide addition (found
at the n—1 position), and mixed DNA samples.

The PCR amplification of tetranucleotide STR loci typically produces a minor product
peak four bases shorter (n—4) than the corresponding main allele peak. This is referred
to as the stutter peak or product. Sequence analysis of stutter products at
tetranucleotide STR loci has revealed that the stutter product is missing a single
tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Such measurements have been made for hundreds of samples at the loci used in
the SGM Plus™ Kit.
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Some of the general conclusions from these measurements and observations are as
follows:

» For each SGM Plus™ Kit locus, the percent stutter generally increases with allele
length, as shown in Figure 6 through Figure 8 on page 76 through page 76.
Smaller alleles display a lower level of stutter relative to the longer alleles within
each locus. This is reflected in Figure 6 through Figure 8, where minimal data
points are plotted for some smaller alleles, because stutter was not detected for
many of these samples.

¢ For the alleles within a particular locus, the percent stutter is generally greater for
the longer allele in a heterozygous sample (this is related to the first point above).

¢ Each allele within a locus displays a percent stutter that is quite reproducible; the
average of the standard deviation values measured for each allele at each locus is:
0.4% for THO1, 0.6% for D351358, vWA and FGA, 0.8% for D851179, D21511 and
D18551, 0.9% for D165539, and 1% for D195433 and D251338. The expected range
of percent stutter for any particular allele can be estimated as + 3 standard
deviations from the mean. For example, if the percent stutter for a particular allele
averages 5% for multiple replicates, and if the average standard deviation at the
allele is 0.5%, then the expected range in percent stutter for this allele is
(6 £1.5%) = 3.5-6.5%. This range also provides an estimate of the maximum
expected stutter percent for each allele.
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* The highest percent stutter observed for any THO1 allele was <4%, for any
D351358, D851179, vWA or FGA allele <9%, for any D165539 or D21S511 allele
<10%, for any D251338 allele <12%, for any D18551 allele <13%, and for any
D195433 allele <14%.

¢ An upper-limit stutter percent interpretational threshold can be estimated for
each locus as 3 standard deviations above the highest percent stutter observed at
the locus (see above two observations). Peaks at the stutter position that are above
this threshold are not expected to be observed in single-source samples and
therefore can be noted for closer examination. The upper-limit threshold values
for each locus are as follows: 6% (THO1), 11% (D351358, vWA, FGA), 12%
(D851179), 13% (D16S539, D21S11), 15% (D2S1338), 16% (D18S51), and 17%
(D195433). For evaluation of mixed samples, see “DAB 8.1.2.2 Mixture Studies”
on page 77.

¢ The percent stutter does not change significantly with the quantity of input DNA,
for on-scale data with a minimum analyzed peak height of 150 relative
fluorescence units (RFU). The measurement of percent stutter may be unnaturally
high for main peaks that are off-scale. Loading or injecting less of the PCR
product will yield accurate quantitation. See “DNA quantification” on page 19 for
information on off-scale data.
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Figure 6 Stutter percentages for the D351358, VWA, D165539, and D251338 loci
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Figure 7 Stutter percentages for the D851179, D21511, and D18S51 loci.
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Figure 8 Stutter percentages for the D19S433, THO1, and FGA loci.
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Addition of 3" A
nucleotide

DAB 8.1.2.2 Mixture
Studies

Section 5.1 Developmental Validation

Extra peaks in the electropherogram

AmpliTaq Gold™ enzyme, like many other DNA polymerases, can catalyze the
addition of a single nucleotide (predominately adenosine) to the 3" ends of
double-stranded PCR products (Clark, 1988, Magnuson et al., 1996).This non-template
addition results in a PCR product that is one base pair longer than the actual target
sequence, and the PCR product with the extra nucleotide is referred to as the “+A”
form.

The efficiency of “A addition” is related to the particular sequence of the DNA at the

3’ end of the PCR product. The SGM Plus™ Kit includes two main design features
that promote maximum A addition:

* The primer sequences have been optimized to promote A addition.

* The last thermal cycling step is 60°C for 45 minutes.

This final extension step gives the AmpliTaq Gold" DNA polymerase extra time to
complete A addition to all double-stranded PCR product. STR systems that have not
been optimized for maximum A addition may have “split peaks”, where each allele is
represented by two peaks one base pair apart (Figure 9).

Figure 9 Split peaks resulting from incomplete A nucleotide addition due to omission of the
45-minute extension step
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Lack of full A nucleotide addition may be observed in SGM Plus"" Kit results when
the amount of input DNA is greater than approximately 5.0 ng. The reason for this is
that more time is needed for AmpliTaq Gold"™ DNA Polymerase to add the A
nucleotide to all molecules as more PCR product is generated. Amplification of too
much input DNA will also result in off-scale data (see “DNA quantification” on page
19 for more information on off-scale data).

“Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

Evidence samples may contain DNA from more than one individual. The possibility of
multiple contributors should be considered when interpreting the results. We
recommend that individual laboratories assign a minimum peak height threshold
based on validation experiments performed in each laboratory to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

In the discussion below, a peak is defined as any peak that is greater than 150 RFU. We
recommend a minimum peak height threshold to avoid typing less than 35 pg of input
DNA (see “Effect of DNA quantity on results” on page 85).
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Chapter 5 Experiments and Results

Extra peaks in the electropherogram

Detection of mixed samples

Each of the following can aid in determining whether a sample is a mixture:
¢ The presence of more than two alleles at a locus

* The presence of a peak at a stutter position that is significantly greater in
percentage than what is typically observed in a single-source sample (see “Stutter
products” on page 74 and Figure 6 through Figure 8).

* Significantly imbalanced alleles for a heterozygous genotype
The peak height ratio is defined as the height of the lower peak (in RFU) divided
by the height of the higher peak (in RFU), expressed as a percentage. Mean peak
height ratios and standard deviations observed for alleles in the SGM Plus"" Kit
loci in unmixed population database samples are as follows:

Allele Mean Peak Height Ratio Number of Observations (n)
D351358 93+ 4% 68
VWA 93+5% 74
D165539 92 + 6% 70
D251338 91+ 6% 87
Amelogenin 90+ 6% 46
D8S1179 92 + 6% 93
D21S11 91+ 7% 95
D18S51 91+ 6% 100
D195433 92+ 6% 97
THO1 92 + 6% 70
FGA 93 +5% 80

¢ For all 11 loci, the mean peak height ratios indicate that the two alleles of a
heterozygous individual are generally very well balanced. Ratios <70% are rare in
normal, unmixed samples.

If the peak height ratio is <70% for one locus, and there are no other indications
that the sample is a mixture, the sample may be reamplified and reanalyzed to
determine if the imbalance is reproducible. Reproducible imbalance at only one
locus may indicate a mixture of significantly overlapping genotypes. Other
possible causes of imbalance at a locus are degraded DNA, presence of inhibitors,
extremely low amounts of input DNA, or the presence of an allele containing a
rare sequence that does not amplify as efficiently as the other allele. Amplification
and analysis of additional loci may assist in the interpretation of the sample.

78 AmpFISTR™ SGM Plus™ PCR Amplification Kit User Guide



Section 5.1 Developmental Validation

Extra peaks in the electropherogram

Resolution of genotypes in mixed samples
A sample containing DNA from two sources can be comprised (at a single locus) of
any of the seven genotype combinations listed below.
* Heterozygote + heterozygote, no overlapping alleles (four peaks)
* Heterozygote + heterozygote, one overlapping allele (three peaks)
* Heterozygote + heterozygote, two overlapping alleles (two peaks)
¢ Heterozygote + homozygote, no overlapping alleles (three peaks)
* Heterozygote + homozygote, overlapping allele (two peaks)
¢ Homozygote + homozygote, no overlapping alleles (two peaks)
¢ Homozygote + homozygote, overlapping allele (one peak)
Specific genotype combinations and input DNA ratios of the samples contained in a

mixture determine whether it is possible to resolve the genotypes of the major and
minor component(s) at a single locus.
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The ability to obtain and compare quantitative values for the different allele peak
heights on Life Technologies instruments provides additional valuable data to aid in
resolving mixed genotypes. This quantitative value is much less subjective than
comparing relative intensities of bands on a stained gel.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided from
known reference sample(s).

Limit of detection of the minor component

Mixtures of two DNA samples were examined at various ratios (1:1 to 1:20). The total
amount of genomic input DNA mixed at each ratio was 1 ng.

The samples were amplified in a GeneAmp"" PCR System 9600 and were
electrophoresed and detected using a 377 DNA Sequencer.

The results of the mixed DNA samples, shown separately in Figure 10 on page 80, are
displayed in Figure 11 on page 81 where sample A was the minor component and
sample B was the major component.
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The genotypes of the samples in Figure 10 are the following:

Genotype
Allele
Sample A Sample B

Amelogenin XY XY
D19S433 14,15 15,15

D3S1358 15, 16 14,17
- D8s1179 12,13 12,14

VWA 14, 16 15,17
CTHOT 7,9.3 7,8

D21511 28, 31 30, 30.2

FGA 24, 26 22, 22

D16S539 9,10 11,12
D18S51 12,15 15, 16

D251338 20, 23 19, 25

For these 1 ng total DNA mixture studies, the limit of detection is when the minor
component is present at approximately 1/20 of the concentration of the major
component. The limit of detection for the minor component is influenced by the
combination of genotypes in the mixture.

The following figures show the reference samples and the two DNA samples used for

this study.

Figure 10 Reference samples for mixture study shown in next figure
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Figure 11 Results of the two DNA samples from previous figure mixed together at defined ratios and amplified with the
SGM Plus™ Kit. The A:B ratios shown are 1:1, 1:3, 1:5, 1:10, and 1:20 (top to bottom). Alleles attributable only to the
minor component are highlighted.
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Simulation of forensic casework scenarios was achieved by combining various body
fluids (blood:blood, semen:blood, and semen:saliva) from two donors in defined
ratios, by volume, from 1:1-1:50.

Mixed stains were prepared and DNA was extracted at the Santa Clara County Crime
Laboratory, San Jose, CA, following the phenol/chloroform procedure (differential
lysis was performed on stains containing semen). At Applied Biosystems
approximately 3 ng of DNA was amplified from each dried fluid mixture in a
GeneAmp PCR System 9600 and detected using either the Applied Biosystems 310
Genetic Analyzer or the Applied Biosystems 377 DNA Sequencer.

The limit of detection of the minor genotype component of each body fluid mixture
ratio was determined. The limit of detection is defined here as the ratio below which a
mixture is not recognized but rather appears to contain DNA from a single source (the
major contributor of the mixture). The limit of detection occurred in blood:blood
mixtures when the minor component was present at one tenth the volume of the major

genotype.
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Chapter 5 Experiments and Results

Characterization of loci

In epithelial cell fractions of differential extractions of semen:blood or semen:saliva
stains, blood was detectable at one fiftieth and saliva at one tenth the volume of semen.
Sperm DNA carryover into the epithelial cell fraction of these stains was detectable at
one-tenth the volume of blood or saliva. In sperm fractions, the male genotype was
detectable from every semen:blood or semen:saliva mixture with no trace of the female
DNA.

Again, the limit of detection for the minor component is influenced by the specific
combination of genotypes present in mixtures.

Note that the limit of detection for the minor component is influenced by the specific
combination of genotypes present in mixtures.

Analysis of sexual assault DNA mixture evidence

SGM Plus" Kit reactions with DNA extracted from adjudicated sexual assault evidence
were examined to assess the performance of the SGM Plus'" Kit on typical casework
samples comprised of mixed body fluids. These samples were extracted, amplified, and
analyzed in collaboration with the Santa Clara County Crime Laboratory.

DNA extracts from three adjudicated sexual assault cases were prepared by DNA
analysts at the Santa Clara County Crime Laboratory. Sexual assault evidence materials
were processed using the differential lysis and organic extraction procedure, while
victim/suspect reference blood samples were processed using the Chelex"" extraction
procedure. Following amplification with the SGM Plus™ Kit reagents, the PCR products
were analyzed using the Applied Biosystems 377 DNA Sequencer.

* Case 1 and Case 2 contained a victim reference blood sample, a suspect reference

blood sample, and a victim vaginal swab. The SGM Plus™ Kit genotype of the
epithelial cell fraction was the same as that of the victim reference and did not

contain alleles foreign to the victim. The SGM Plus™ Kit genotype of the sperm
cell fraction did not contain detectable epithelial cell fraction DNA and included
the suspect as a possible semen donor.

¢ Case 3 contained a victim reference blood sample and a victim vaginal swab. The
SGM Plus™ Kit genotype of the epithelial cell fraction was the same as that of the
victim reference and did not contain alleles foreign to the victim. In accordance

with the victim’s account, SGM Plus" Kit genotypes of the sperm fraction
revealed DNA from multiple semen donors. No suspect(s) were developed in this
case.

Characterization of loci

DAB 8.1.2.1
Documentation

Nature of the
polymorphisms

82

“Documentation exists and is available which defines and characterizes the locus.” (DAB,
1998).

The primers for the amelogenin locus flank a six-base pair deletion within intron 1 of
the X homologue. Amplification results in 107-bp and 113-bp products from the X and
Y chromosomes, respectively. (Sizes are the actual base pair size according to
sequencing results, including 3' A nucleotide addition.) The remaining SGM Plus""
Kit loci are all tetranucleotide short tandem repeat (STR) loci. The length differences
among alleles of a particular locus result from differences in the number of 4-bp repeat
units (see Table 1 on page 12).
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Mapping

Population studies
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Species specificity

Alleles in the AmpF(STR™ SGM Plus™ Allelic Ladder, alleles containing partial
repeat units, population database, and nonhuman primate DNA samples have been
subjected to DNA sequencing at Life Technologies. In addition, other groups in the
forensic community have sequenced alleles at some of these loci (Nakahori ef al.,
1991; Puers et al., 1993; Moller et al., 1994; Barber et al., 1995; Moller and Brinkmann,
1995; Barber et al., 1996; Barber and Parkin, 1996; Brinkmann ef al., 1998; Momhinweg
et al., 1998; Watson et al., 1998). Among the various sources of sequence data on the

SGM Plus™ Kit loci, there is consensus on the repeat patterns and structure of the
STRs (see Table 1 on page 12).

D195433 alleles have been sequenced at Life Technologies, including those in the
AmpF(STR™ SGM Plus™ Allelic Ladder. Sequenced D195433 alleles that contain a 2—
bp repeat unit result from a deletion of the last two nucleotides (AG) in the second
tetranucleotide repeat unit (AAAG) of the repeat motif (see Table 1 on page 12).

The SGM Plus™ Kit loci have been validated by family studies in order to
demonstrate their mode(s) of inheritance.

The Centre d’Etude du Polymorphisme Humain (CEPH) has collected DNA from

39 families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to characterize
the mode of inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al.,1992).

Four CEPH family DNA sets were examined. DNA input of 1.5 ng from each sample
was amplified using the SGM Plus™ Kit, followed by analysis using an Applied
Biosystems 377 DNA Sequencer. The families examined included #1331 (11 offspring),
#13291 (9 offspring), #13292 (9 offspring), and #13294 (8 offspring), representing

37 meiotic divisions. The results confirmed that the loci are inherited according to
Mendelian rules, as has been reported in the literature (Nakahori et al.,1991; Edwards
et al.,1992; Kimpton et al.,1992; Mills et al.,1992; Sharma and Litt, 1992; Li et al.,1993;
Straub et al.,1993).

The SGM Plus™ Kit loci D351358, vVWA, D16S539, D251338, amelogenin, D8S1179,
D21511, D18551, D195433, THO1, and FGA have been mapped and the chromosomal
locations have been published (Nakahori et al., 1991; Edwards et al.,1992; Kimpton et
al.,1992; Mills et al.,1992; Sharma and Litt,1992; Li et al.,1993; Straub et al.,1993; Barber
and Parkin,1996). They are listed in Table 1 on page 12.

Population distribution data of the 11 SGM Plus™ Kit loci have been established in
different racial and/or ethnic groups. These loci were amplified and typed for 200 U.S.
Caucasian and 195 African-American individuals. For more information regarding
analysis of these samples, see “Population data” on page 92

Species specificity

DAB 8.1.2.2
Species Specificity

“Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).
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Species specificity

Nonhuman studies
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Nonhuman DNA may be present in forensic casework samples. The SGM Plus™" Kit
provides the required degree of specificity such that it is specific to primates for the
species tested (with the exception of the amelogenin locus).

The following experiments were conducted to investigate interpretation of SGM
Plus"" Kit results from nonhuman DNA sources.

The extracted DNA samples were amplified in SGM Plus™ Kit reactions and
analyzed using the Applied Biosystems 377 DNA Sequencer.

* Primates — Gorilla, chimpanzee, and macaque (2.5 ng each).

¢ Non-primates — Hamster, rat, rabbit, cat, dog, pig, chicken, cow, and fish (50 ng
each).

* Bacteria and yeast — Legionella, Escherichia, Listeria, Neisseria, Vibrio, Citrobacter,
Salmonella, Candida, Saccharomyces (equivalent to ~50 ng human DNA), and
Rhodotorula.

The primate DNA samples all amplified, producing fragments within the 75-350 base
pair region (Wallin et al.,1998). The primate samples were subsequently sequenced by
Life Technologies scientists. The data revealed significant sequence homology between

the primate and human DNA for the SGM Plus ™ Kit loci (Meyer et al., 1995; Andersen
et al., 1996).

The bacteria, yeast, hamster, rat, rabbit, cat, chicken, and fish samples did not yield
detectable product. The dog, pig, and cow samples produced a 103-bp fragment. This
102-bp fragment was also amplified using the amelogenin primers alone. This
confirms amplification of the product obtained by Buel et al.(1995). The 103-bp
fragment is 4 bp shorter than the primate 107-bp X-specific product (including +A
addition).
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Sensitivity

DAB 8.1.2.2 “Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).
Sensitivity

Effect of DNA The amount of input DNA added to the PCR reaction should be 1.0-2.5 ng. The DNA

guantity on results sample should be quantitated prior to amplification using a system such as the
Quantifiler Human DNA Quantitation Kit (Part no. 4343895). Figure 12 on page 86
shows the effect of different amounts of AmpF(STR™ Control DNA 007.

The final DNA concentration should be in the range of 0.05-0.125 ng/uL so that
1.0-2.5 ng of DNA will be added to the PCR reaction in a volume of 20 pL. If the
sample contains degraded DNA, amplification of additional DNA may be beneficial.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in the following:
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* Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data)

Off-scale data is a problem for two reasons:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, which results in
poor spectral separation (“pull-up”).

Identification of off-scale peaks and multicomponent analysis are discussed in
“DNA quantification” on page 19 and “About multicomponent analysis” on
page 16.

* Incomplete A nucleotide addition
To avoid these issues, the sample can be re-amplified using less DNA.

When the total number of allele copies added to the PCR is extremely low, unbalanced
amplification of the two alleles of a heterozygous individual may occur (Wallin et al.,
1998; Walsh et al., 1992). This is due to stochastic fluctuation in the ratio of the two
different alleles (Sensabaugh et al., 1991). The PCR cycle number and amplification
conditions have been specified to produce low peak heights for a sample containing
produce peak heights of <150 RFU for a sample containing 35 pg human genomic
DNA (corresponding to ten total allele copies). Peak heights <150 RFU should be
interpreted with caution.

Individual laboratories may find it useful to determine an appropriate minimum peak
height interpretational threshold based on their own results using low amounts of
input DNA.
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DAB 8.1.2.2
Stability

Lack of
amplification of
some loci

86

Figure 12 Effect of amplifying various amounts of AmpF(STR™ Control DNA 007 ranging
from 16 pg to 1 ng. Note that the y-axis scale differs in many of these panels.
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“Species specificity, sensitivity, stability and mixture studies are conducted.” (DAB, 1998).

As with any multi-locus system, the possibility exists that not every locus will amplify.
This is most often observed when the DNA substrate has been severely degraded or
when the DNA sample contains PCR inhibitors. Because each locus is an independent
marker, results generally can still be obtained from the loci that do amplify.
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Differential and Differential amplification can be defined as the difference in the degree of
preferential amplification of each locus within a co-amplified system, such that one or more loci
amplification may amplify to a greater extent compared to the other loci. Preferential amplification is

used in this guide to describe differences in the amplification efficiency of two alleles
at a single locus and is observed when the peak height ratio between the two alleles is
<70% (see “DAB 8.1.2.2 Mixture Studies” on page 77).

Preferential amplification of alleles in systems that distinguish alleles based on length
polymorphisms is most likely to be observed when the alleles differ significantly in
base pair size. Because most SGM Plus" Kit loci have small size ranges, the potential
for preferential amplification of alleles is low.

DNA samples containing either D251338 alleles separated by 28-40 bp or containing
FGA alleles separated by 90-100 bp were analyzed in several of our studies to
determine the potential for preferential amplification.

In assessing potential for differential and preferential amplification, the following four
variables were examined:
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* Low template copy number
» Effect of PCR inhibitor in a DNA sample
* Degraded DNA

* Amplification denaturation and annealing temperatures

Low template copy number

To determine if the amount of input DNA may result in either differential or
preferential amplification, varying quantities of three DNA samples were amplified in
duplicate reactions. One nanogram, 0.5 ng, 0.25 ng, 0.125 ng, 0.06 ng, 0.03 ng, and
0.015 ng of AmpF(STR Control DNA 007 and samples containing either widespread
D251338 or FGA alleles were amplified and then analyzed using the Applied
Biosystems 377 DNA Sequencer.

No loci in any of the samples tested differentially amplified at any of the eleven loci.
Preferential amplification was not observed between the widespread D251338 alleles.

For the sample containing widespread FGA alleles, the duplicate dilution series are
denoted here as A and B. In dilution series A, for the sample containing 0.06 ng
template DNA, the shorter of the two widespread FGA alleles (270 bp) was detected
and the longer allele (334 bp) was not. However, the shorter allele peak height

(26 RFU) was significantly below the recommended minimum threshold of 150 RFU
(see “Effect of DNA quantity on results” on page 85). In dilution series A, preferential
amplification was not seen at any of the higher template DNA concentrations.

Moreover, in dilution series B, for the sample containing widespread FGA alleles, such
preferential amplification did not occur at 0.06 ng. But, at 0.125 ng of input DNA, a
peak height ratio of 55% was detected between the widespread FGA alleles. Both FGA
alleles in this sample (93 and 51 RFU) were below the recommended minimum
threshold of 150 RFU (see “Effect of DNA quantity on results” on page 85).

For dilution series A and B, at 0.25 ng and above, both FGA alleles amplified in equal
proportions; at 0.03 ng neither allele was detectable. Taken together, these data
underscore the importance of interpreting single peaks of low fluorescence signal with
caution and on a case-by-case basis.

AmpFtSTR™ SGM Plus™ PCR Amplification Kit User Guide 87



Chapter 5 Experiments and Results
Stability

Effect of inhibitors

Heme compounds have been identified as PCR inhibitors in DNA samples extracted
from bloodstains (Akane ef al., 1994., DeFranchis et al., 1988). It is believed that the
inhibitor is co-extracted and co-purified with the DNA and subsequently interferes
with PCR by inhibiting polymerase activity.

Bovine serum albumin (BSA) can prevent or minimize the inhibition of PCR, most
likely by binding to the inhibitor (Comey et al., 1994). Since the presence of BSA can
improve the amplification of DNA from blood-containing samples, BSA has been
included in the AmpF(STR™ PCR Reaction Mix at a concentration of 8 pg per 50-uL
amplification. BSA has also been identified as an aid in overcoming inhibition from
samples containing dyes, such as in denim.

To examine the effects of hematin on the SGM Plus" Kit amplification results, DNA
samples were amplified using the SGM Plus'" Kit reagents (including the
BSA-containing PCR reaction mix) in the presence of varying concentrations of
purified hematin. The concentrations of hematin used were 0 uM,12 pM, 16 uM,

20 uM, and 24 uM. When the amount of hematin was increased to a concentration that
started to inhibit the PCR, D251338 and D18S51 were the first loci to drop out in each
experiment, followed by FGA (Figure 13).

Figure 13 DNA amplified with the SGM Plus™ Kit in the presence of varying concentrations
of hematin: 0, 12 uM, 16 uM, 20 uM, and 24 uM
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Degraded DNA

As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced. This is due to the reduced number of
intact templates in the size range necessary for amplification.
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Degraded DNA was prepared to examine the potential for differential amplification of
loci. High molecular weight DNA was incubated with the enzyme DNase I for varying
amounts of time. The DNA was examined by agarose gel analysis to determine the
average size of the DNA fragments at each timepoint. Gel analysis results of the
degraded DNA are shown in Figure 14.

Figure 14 Agarose gel of degraded genomic DNA

5
5 5 g
e Q2 <
=] < @
3] © )
£ S i)
— o (‘BD
[0 N 3
—% .. w E)o-
oz 9Q £ £ < . 0 oS =
6o8-§§§&&&;99@fm s
0 5 o N oo £ £ £ £ 4+ 6 =
KX C M ~~ < 0O~ A MO ~ A < 0O NN O o
. 2
o
=}

— 222bp

Four (4) ng of degraded DNA (or 2 ng undegraded DNA) was amplified using the

SGM Plus"" Kit (all 11 primer pairs together) and also in reactions containing each
locus-specific primer pair individually.

The electropherograms in Figure 15 show the SGM Plus™ Kit amplification results of
a DNA sample with no DNase I treatment (2 ng amplified) and those of the 30-
second, 1-, 4-, and 8-minute incubations (approximately 4 ng amplified).
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Figure 15 Amplifications of DNA incubated for various times with DNase |

EE' a0 120 150 180 210 240 270 200
2400 -
= Lull i
o L1l T " 1T
91E :no DNaze, SGMFlus EME 216 :no DMase, SGMFPlus

LI 917 :noDMaze, SGMPlus

N

2B : 20 zec., SGMFluz OB 26 :30s=ec., S6MFPlus
CIm  2v:20 zec., SGMPluz

£00
200 ﬂ ﬂ
0] L id i A dia
9ZE : 1 min., SGMFluz Ol 922G : 1 min., S6MFPlus
CIm 92 :1 min., SGMPlus
400
200
0_| &, _fL j I ettt aich,
93E : 4 min., SGMFluz OB 926 : 4 min., S6MFPlus
LI 92 : 4 min., SGMPlus
400
200
0L g, il i . ——
94E : & min., SGMFluz OE 924G : 2 min., S6MFPlus

LI 94 :2 min., SGMPlus

The loci failed to amplify in the order of decreasing size as the extent of degradation
progressed: D251338 was the first locus to drop out, followed by D18551 and D165539
and so forth. A similar result at each timepoint was obtained whether the DNA

samples were amplified for each locus alone or co-amplified with the SGM Plus"" Kit
(Figure 16).
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Figure 16 Multiplex and single-locus amplifications of the DNA sample incubated for 1 minute
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Denaturation and annealing temperatures

The effects of denaturation and annealing temperatures on the amplification of SGM

Plus" Kit loci were examined using 1-2 ng of three DNA samples: AmpF(STR Control
DNA 007 and samples containing either widespread D251338 or FGA alleles.

The denaturation temperatures tested were 92, 94, and 96°C (DNA Thermal Cycler
480) and 92.5, 94, and 95.5 °C (GeneAmp Detection Systems 2400, 9600, and 9700), all
for 1-minute hold times. The annealing temperatures tested were 57, 59, 61, and 63°C,
also for 1-minute hold times, in the DNA Thermal Cycler 480 and the GeneAmp PCR
Systems 2400, 9600 and 9700. The PCR products were analyzed using the Applied
Biosystems 310 Genetic Analyzer.
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Matrix studies

Neither preferential nor differential amplification was observed in the denaturation
temperature experiments. Of the tested annealing temperatures, 57, 59, and 61°C did
not induce any differential amplification. At 63°C, the yield of the majority of loci was
significantly reduced. This should pose no problem with routine thermal cycler
calibration and when following the recommended amplification protocol. Preferential
amplification was not observed at any of the tested annealing temperatures.

Analysts at the Santa Clara Crime Laboratory prepared a panel of blood and semen
specimens deposited on a variety of commonly encountered substrates. Blood samples
from two donors were deposited individually on wool, cotton, nylon, metal, glass,
leather (one donor), and blue denim. Semen samples from two donors were deposited
individually on wool, cotton, nylon, leather, blue denim, acetate, vinyl upholstery,
facial tissue, and a condom with spermicide (5% nonoxynol-9).

Specimens were stored at room temperature and at specified time points a sampling of
each stain was removed for extraction. The blood and semen stains were extracted
using the organic extraction procedure. Additionally, a portion of each blood specimen
was extracted using the Chelex"" method followed by Centricon™-100 ultrafiltration.
Extracted samples were then stored at —15 to —-25°C for 4-5 years.

The 1-week and 1-year time points were analyzed by Life Technologies scientists.
The samples were amplified using SGM Plus™ Kit reagents and analyzed using the
Applied Biosystems 310 Genetic Analyzer. A complete 11-locus genotype was
obtained for 47 of the 49 blood and semen samples exposed to the tested matrices for 1
week or 1 year. Some alleles in two of the 1-year samples were of low signal intensity
and were either too weak to be genotyped or were interpreted with caution. No non-
specific artifacts were generated and all samples yielded expected genotypes.

Population data

DAB 8.1.2.3
Population Data

DAB 8.1.2.3.1
Population
Distribution Data

Overview

92

“Population distribution data are documented and available.” (DAB, 1998).

“The population distribution data would include the allele and genotype distributions for the
locus or loci obtained from relevant populations. Where appropriate, databases should be tested
for independence expectations.” (DAB, 1998).

To interpret the significance of a match between genetically typed samples, it is
necessary to know the population distribution of alleles at each locus in question. If the
genotype of the relevant evidence sample is different from the genotype of the
suspect’s reference sample, then the suspect is “excluded” as the donor of the
biological evidence tested. An exclusion is independent of the frequency of the two
genotypes in the population.

If the suspect and evidence samples have the same genotype, then the suspect is
“included” as a possible source of the evidence sample. The probability that another,
unrelated, individual would also match the evidence sample is estimated by the
frequency of that genotype in the relevant population(s).
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Population The SGM Plus™ Kit was used to generate the population data provided in this
samples used in section. Samples were collected from individuals throughout the United States with
these studies no geographical preference.
Population Number of samples Samples provided by
African-American 195 Laboratory Corporation of America
U.S. Caucasian 200
w)
5
Allele frequencies  Table 4 shows the SGM Plus"" Kit allele frequencies in two populations, listed )
as percentages. 3
Table4 SGM Plus™ Kit allele frequencies %
Allele African-American (n = 195) U.S. Caucasian (n = 200) %
D351358 §
9 0.267 ¥
11 0.26" ' 0.251
12 0517 0.257
13 ¥ 0.50"
14 11.80 11.25
15 27.95 ' 28.25
15.2 0.267 ¥
16 32.31 22.25
17 21.80 22.25
18 4.62 ' 14.50
19 0.267 0.50"
VWA
1 0.267 ¥
12 t ' 1
13 1.54 ¥
14 7.70 8.50
15 22.05 8.25
16 26.92 ' 19.75
17 16.92 25.00
18 13.85 25.75
19 8.46 11.00
20 2.05 ' 150
21 ¥ 0.25"
22 0.26" ¥
23 s s
24 ¥ ¥
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Allele African-American (n = 195) U.S. Caucasian (n = 200)

D165539

5 0.26" E:

8 3.85 15
9 18.21 10.75
10 11.28 4.25
11 30.00 29.75
12 18.46 ' 34.25
13 15.64 17.5
14 2.05 1.75
15 0.26" 0.25"
D251338

15 t 0.25%
16 5.64 4.25
17 11.03 17.75
18 2.82 ' 8.75
19 16.41 12.75
20 8.72 13.50
21 13.59 3.25
22 12.31 ' 3.75
23 8.72 10.75
24 8.46 10.00
25 8.72 12.00
26 2.82 ' 2.75
27 051t E:
28 0.26" 0.25%
D8S1179

8 1 1.75
9 0.51% 1.00t
10 3.08 8.00
11 4.36 6.25
12 1051 ' 14.25
13 19.74 34.75
14 33.33 18.75
15 21.03 13.00
16 6.41 ' 2.00
17 1.03t 0.25%
18 ¥ t
19 ¥ ¥
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Allele African-American (n = 195) U.S. Caucasian (n = 200)
D211
2% 1 ' 1
24.2 1 0.50*
25 1 :
26 0.26" E: o
27 5.90 3.75 5
28 21.80 ' 16.25 ?D
28.2 t f =
29 20.00 20.75 s
292 t 0.50" 5
29.3 0.26" ' ¥ 3
30 16.15 26.25
30.2 2.56 2.50
31 8.97 5.50
31.2 5.90 ' 10.50
32 0.77* 1.25t
32.2 6.92 7.25
33 0.51F 0.25"
33.1 0.26" ' E:
33.2 410 4.00
34 0.26" E:
34.2 1 0.75"
35 3.59 ' E:
35.2 t f
36 1.54 E:
37 ¥ ¥
38 0.26" E:
D18S51
7 ¥ ¥
9 ¥ ¥
10 0517 ' 0.50*
10.2 0.51% E:
11 1.54 2.00
12 5.64 14.25
13 410 ' 15.00
13.2 0.51F E:
14 6.67 16.75
14.2 0.51 E:
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Allele African-American (n = 195) U.S. Caucasian (n = 200)
15 17.69 14.25
16 17.44 ' 14.00
17 16.41 10.50
18 11.03 6.00
19 10.26 3.75
20 4.87 1.50
21 1.03t ' 1.00t
22 1.03t 0.25"
23 0.26" 0.25%
24 1 :
25 ' 1
2% 1 E:
27 1 :
D195433
9 t E:
10 0.77* :
10.2 0.26" E:
11 7.70 0.25%
1.2 0.26" ' E:
12 1051 6.50
12.2 410 E:
13 26.92 26.00
13.2 4.62 ' 2.25
14 21.80 32.75
14.2 5.90 3.25
15 7.44 18.25
15.2 4.87 ' 2.50
16 0.77* 5.25
16.2 3.33 2.00
17 1 0.50*
17.2 0517 ' 0.25"
18.2 0.26" 0.25%
THO1
4 ¥ ¥
5 0.26 ' t
6 13.08 25.25
7 40.00 16.00
8 22.82 9.25
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Allele African-American (n = 195) U.S. Caucasian (n = 200)

9 13.08 13.75

9.3 10.00 ' 35.00

10 0.77* 0.75%

1 1 :

13.3 1 f o
FGA s
16.2 0.26" ' E: ?%D
17 0.26" E: =
18 0.51% 1,50 s
19 4.62 6.25 5
19.2 0.26" ' ¥ 3
20 4.36 16.25

20.2 1 0.75%

21 13.33 17.75

21.2 0.26" ' E:

22 18.97 16.50

22.2 0.26" 0.50*

23 18.97 14.00

24 16.41 ' 13.25

25 12.31 11.25

26 4.10 1,50

26.2 1 :

27 410 ' 0.50*

28 0.77* E:

29 0.26" E:

30 ¥ ¥

30.2 1 ¥

31.2 t f

32.2 1 f

33.2 1 E:

34.2 1 :

42.2 1 :

43.2 1 f

44.2 1 E:

45.2 1 :

46.2 1 :

47.2 1 f

48.2 1 E:
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Allele African-American (n = 195) U.S. Caucasian (n = 200)
50.2 ¥ ¥
51.2 1 1

T A minimum allele frequency of 1.3% is suggested by the National Research Council in forensic calculations
using either of these African American or U.S. Caucasian databases analyzed using the SGM Plus™ Kit.

1 Presen tin the AmpF(STR™ SGM Plus™ Allelic Ladder but not observed in the respective population database
samples.

Analyzing the two databases

Analysis across both databases of 790 total chromosomes (per locus) revealed a total of
11 different D35S1358 alleles, 11 different vWA alleles, 9 different D16S539, 14 different
D251338 alleles, 10 different D851179 alleles, 21 different D21S11 alleles, 17 different
D18S51 alleles, 17 D195433 alleles, 7 different THO1 alleles, and 18 different FGA
alleles.

In addition to the alleles that were observed and recorded in the Applied Biosystems

databases, other known alleles (listed in Table 1, “SGM Plus'" Kit loci and alleles” on
page 12) have either been published or reported to us by other laboratories.

Independent allele frequencies

Independence of allelic frequencies within a locus can be expressed by the Hardy-
Weinberg (HW) relationship. Approximation of HW expectations in a sample
population allows estimation of genotypic frequencies (HW proportions) from
observed allelic frequencies using the HW equation (expanded binomial square law)
(Hartl and Clark, 1989; Weir, 1996).

Several biostatistical tests were used to survey HW relationships at the SGM Plus™
Kit STR loci in each sample population. Independence was found between alleles
within each locus, as p values >0.05 were obtained from the homozygosity test
(Chakraborty et al., 1988; Nei and Roychoudhury, 1974; Nei, 1978), likelihood-ratio
test (Edwards et al., 1992; Weir, 1992), and Guo-Thompson exact test (Guo and
Thompson, 1992).

Additionally, allele frequency data were analyzed for independence based on the total
number of observed distinct homozygous and heterozygous genotype classes (Nei,
1978; Chakraborty et al., 199). Observed values were within two standard errors of
expected values for each locus. These sets of data demonstrate that appropriate
estimations of SGM Plus"" Kit genotype frequencies are generated from allele
frequencies observed in the Life Technologies African-American and U.S. Caucasian
databases.

Random association

Existence of random association (linkage equilibrium) between all 10 STR loci was
established through two separate statistical tests. Results of the first test, which
considers the observed variance of the number of heterozygous loci (Brown et al.,
1980; Budowle et al., 1995) indicate that in both population samples, all SGM Plus™
Kit loci are inherited independently.
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Mutation rate

Pairwise interclass correlation tests were performed between every possible two-locus
combination across the African-American and U.S. Caucasian databases (Karlin et al.,
1981). Mendelian behavior between the ten STR loci was observed. SGM Plus ™ Kit
multilocus genotype frequency estimates may be derived through direct
multiplication of each single-locus genotype frequency (the “product rule”) estimated
from the Applied Biosystems African-American and U.S. Caucasian databases.

Low frequency alleles

Some alleles of the SGM Plus™ Kit loci occur at a low frequency (less than five times
in either database). For these alleles, a minimum frequency of 0.013 (five divided by
2n, where n equals the number of individuals in the database) was assigned for the
SGM Plus™ Kit African-American and U.S. Caucasian databases, as suggested in the
1996 report of the Committee on DNA Forensic Science (National Research Council,
1996). These databases are summarized in Table4,“SGMPlus ™ Kit allele frequencies”
on page 93. The minimum reportable genotype frequency at each locus is then 1.69 X
104, giving a minimum combined multilocus genotype frequency of 1.90 X 1038 for
both the African-American and U.S. Caucasian databases.
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Mutation rate

Estimation of spontaneous or induced germline mutation at genetic loci can be
achieved by comparing the genotypes of offspring to those of their parents. From such
comparisons the number of observed mutations are counted directly.

Genotypes of the ten STR loci amplified by the SGM Plus™ Kit were determined for a
total of 146 parent-offspring allelic transfers (meioses) at the Forensic Science Service,
Birmingham, England. One length-based STR mutation was observed at the D18511
locus; mutation was not detected at any of the other nine STR loci. The D18511
mutation was represented by an increase of one 4-bp repeat unit, a 17 allele was
inherited as an 18 (single-step mutation). The maternal/paternal source of this
mutation could not be distinguished.

Additional studies (Edwards et al., 1991; Edwards ef al., 1992; Weber and Wong, 1993;
Hammond et al., 1994; Brinkmann ef al., 1995; Chakraborty et al., 1996; Chakraborty et
al., 1997; Brinkmann et al., 1998; Momhinweg ef al., 1998; Szibor et al., 1998) of direct
mutation rate counts produced:

* Larger sample sizes for some of the SGM Plus"" Kit loci.

e Methods for modifications of these mutation rates (to infer mutation rates
indirectly for those loci where the rates are not large enough to be measured
directly and/or to account for those events undetectable as Mendelian errors).
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Chapter 5 Experiments and Results
Probability of identity

Probability of identity

Table 5 shows the Probability of Identity (Py) values of the SGM Plus™ Kit
loci individually and combined.

Table5 Probability of Identity values for the SGM Plus™ Kit STR loci

Locus African-American U.S. Caucasian
D351358 0.102 0.078
VWA 0.058 0.065
D16S539 0.066 | 0.103
D251338 0.021 0.024
D8S1179 0.075 | 0.047
D21511 0.033 0.045
D18S51 | 0.028 | 0.030
D195433 0.039 0.078
THO1 | 0.102 | 0.09%
FGA 0.035 0.036
Combined 7.91 X 10-14 2.99 X 10-13

The P; value is the probability that two individuals selected at random will have an
identical SGM Plus'" Kit genotype (Sensabaugh, 1982). The P; values for the
populations described in this section are then approximately 1/1.3 X 1013 (African-
American) and 1/3.3 X 1012 (U.S. Caucasian).

Of 18,915 and 19,900 pairs of SGM Plus'" Kit profiles represented by the African-
American and U.S. Caucasian databases, respectively, no 10-locus matches were
observed.

Linkage disequilibrium between the SGM Plus"" Kit loci and unique loci included in
the AmpF(STR ™ Profiler™ PCR Amplification Kit (TPOX, CSF1PO, D5S818, D135317,
and D75820) was not detected. The combination of these 15 AmpF(STR™ kit loci
offers an average probability of identity of approximately 1/2.2 X 10'8 (African-
American) and 1/2.1 X 1017 (U.S. Caucasian).

Probability of paternity exclusion

100

Table 6 shows the Probability of Paternity Exclusion (Pg) values of the SGM Plus™
Kit STR loci individually and combined.

Table6 Probability of paternity exclusion values for the SGM Plus™ Kit loci

Locus African-American U.S. Caucasian
D351358 0.5260 0.5797
VWA 0.6394 0.6170
D165539 0.6146 | 0.5252
D251338 0.7818 0.7678
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Probability of paternity exclusion

Locus African-American U.S. Caucasian
D8S1179 0.5930 0.6128
D21S11 0.7281 0.6835
D18S51 0.7518 0.7414
D19S433 0.7031 0.5865
THO1 0.5250 0.5418
FGA 0.7202 0.7173
Combined 0.99998 0.99997

The Pg value is the probability, averaged over all possible mother-child pairs, that a
random alleged father will be excluded from paternity after DNA typing of the SGM
Plus™ Kit STR loci (Chakraborty and Stivers, 1996).

The Pg value offered by the combination of the 10 AmpF(STR™ kit loci (D351358,
vWA, D165539, D251338, D8S1179, D21S11, D18551, D19S433, THO1, FGA) amplified
by the AmpF{STR SGM Plus and Profiler kits is approximately 0.9999997 for the
African American database and approximately 0.9999992 for the U.S. Caucasian

database.
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement

Overview

Section 5.2 Performance Validation After Buffer and
Enzyme Component Replacement

Overview

Experiments

102

As part of an ongoing program to exercise greater control over raw materials used in
the AlronéSTRTM PCR Amplification Kits, manufacturing of the AmpliTaq Gold™
enzyme and 10X PCR Buffer II (Tris-KCl buffer) components is transitioning from
Roche Molecular Systems to Life Technologies. Manufacturing of both components by
Life Technologies will be conducted according to the same specifications used
previously by Roche. The in-house components are established raw materials in our

next generation kits (for example, the NGM", NGM SElect"" and Identifiler" Plus
Kits).

We performed studies to compare the performance of the SGM Plus'" Kit containing
the in-house components (updated kit) with the performance of the original kit,
focussing on studies most relevant to forensic DNA testing (see SWGDAM Guidelines
effective January 1, 2011). These studies, while not exhaustive, are in our opinion
appropriate for a manufacturer.

Our studies compared the performance of two Roche-manufactured enzyme and
buffer lots (Control mixes) with three new lots of buffer and two new lots of enzyme
manufactured by Life Technologies (Test mixes). Studies were performed using Test
mixes containing both the enzyme and buffer manufactured by Life Technologies.

Test_ Control Amix | Control B mix @ Test A mix Test B mix Test C mix
Material
Buffer Control Buffer | Control Buffer | Test Buffer Test Buffer Test Buffer
Lot 1 Lot 2 Lot 1 Lot 2 Lot 3
Enzyme Control Control TestEnzyme | Control TestEnzyme
Enzyme Enzyme Lot 1 Enzyme Lot 2
Lot 1 Lot 2 Lot 2

Each of the five mixes listed above were used to conduct reproducibility, sensitivity,
and inhibition studies. All amplifications were performed using a GeneAmp' " PCR
System 9700 with either silver or gold-plated silver block using the recommended
amplification conditions and cycle number for the SGM Plus™ Kit. All data was run
on an Applied Biosystems 3130x! Genetic Analyzer running Data Collection Software
v3.0 and analyzed using GeneMapper " ID-X Software. Subsequent data analysis was
performed using Minitab'" Statistical Software.
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Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement
Reproducibility study

Reproducibility study

For the reproducibility study, 12 replicates of control DNA 007 at 2 ng input and three
negative control replicates were amplified. The results were evaluated for intracolor
balance, stutter percentage, and the presence, signal intensity, and location of artifacts.

Intracolor balance No significant difference (<10% increase or decrease) in the level of intracolor balance
was observed between the Test and Control mixes (Figure 17).

Figure 17 Reproducibility study: intracolor balance
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Stutter Stutter percentage results for each marker were comparable across all Test and Control
percentages mixes (Figure 18)
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Reproducibility study

Figure 18 Reproducibility study: mean stutter percentage
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Artifacts Known artifacts observed showed the same morphology, signal intensity, and

location in all Test and Control mixes and do not exceed 50 RFU, except for the

NED™ dye artifacts highlighted in Figure 19. No new artifacts were observed in the
Test mixes.
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Figure 19 Reproducibility study: known artifacts (Y-scale 100 RFU)
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement

Sensitivity study

Sensitivity study

Mean peak height

106

For the sensitivity study, dilution series of three genomic DNA samples were
amplified: 2 ng (three replicates), 1 ng, 0.5 ng, and 0.25 ng (four replicates each). The
results were evaluated for mean peak height, degree of linearity between input DNA
concentration and peak height, level of allelic dropout at 250 pg, and genotype
concordance.

Overall mean peak height observations were consistent between all Test and Control
mixes (Figure 20) demonstrating equivalent performance (Figure 21). Sample IBB286
produced a wider spread between data points. However, this spread did not correlate
to a difference in Test versus Control mixes and is likely due to variability in sample
set up.

Figure 20 Sensitivity study: mean peak heights for three genomic DNA samples
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Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement
Sensitivity study

Figure 21 Sensitivity study: representative electropherograms for Sample 2 amplified using 250 pg input DNA (Y-scale 500
RFU)
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DNA concentration  The calculated slope and R? values for each of the plotted curves are equivalent,
and peak height showing comparable relationships between peak height and DNA input amount for
the Test and Control mixes (Figure 22).

Figure 22 Sensitivity study: linear regression plot of combined mean peak height for three
genomic DNA samples

R=zgent Lot
1200 —— Contral A
* Control B
—— Test A
—— TestB
1000 Tet O
=
=
£ 800!
= .
d
; a0 -
400 4
200 ¥
] 500 1000 1500 2000
DHNA Input Amount (pg)

AmpFISTR™ SGM Plus™ PCR Amplification Kit User Guide 107



Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Allelic dropout No allelic dropout was observed for any of the Test or Control mixes.
Genotype Genotypes for Test and Control mixes were 100% concordant (Table 7).
concordance Table 7 Sensitivity study: genotype concordance
DNA Input Amount Reagent Mix Genotype Concordance
250 pg Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%
500 pg | Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%
1 ng Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%
2 ng | Test A 100%
Test B 100%
Test C 100%
Control A 100%
Control B 100%

Inhibition study

An inhibition series of 2 ng control DNA 007 consisting of uninhibited control, humic
acid at a final concentration of 15.2 ng/uL, and hematin at a final concentration of

40 uM in replicates of five were amplified using each of Test and Control mixes. The
amount of each inhibitor tested was titrated to cause an approximate 50% reduction in
overall peak height of the samples. Results were evaluated for mean peak height,
minimum peak height, intracolor balance, and levels of allelic dropout.

Mean peak height, No significant difference in mean peak height, mean minimum peak height and
minimum mean intracolor balance was observed for any Test or Control mixes tested on uninhibited
Control DNA 007 and Control DNA 007 inhibited with hematin or humic acid.

peak height, and (Figure 23, 24, and 25).

intracolor balance
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Inhibition study

Figure 23 Inhibition study: mean peak height
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Inhibition study

Figure 25 Inhibition study: intracolor balance
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Representative electropherograms from the inhibition study are shown in Figure 26,
Figure 27, and Figure 28.

Figure 26 Inhibition study: representative electropherograms using uninhibited Control DNA 007 (Y-scale 4000 RFU)
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Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Figure 27 Inhibition study: representative electropherograms using Control DNA 007 inhibited with 40 pM Hematin (Y-scale
4000 RFU)
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Figure 28 Inhibition study: representative electropherograms using Control DNA 007 inhibited with15.25 ng/pL Humic Acid
(Y-scale 4000 RFU)
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Conclusions

Allelic dropout No allelic dropout events were seen for any Test or Control mixes tested on
uninhibited Control DNA 007 and Control DNA 007 inhibited with hematin or humic
acid.

Conclusions

Laboratories can expect to obtain equivalent quality profiles across a wide range of
forensic samples when using the SGM Plus™ Kit containing the AmpliTaq Gold™
enzyme and 10X PCR Buffer II manufactured by Life Technologies as compared to
the original SGM Plus™ Kit containing AmpliTaq Gold"" enzyme and 10X PCR Buffer
II manufactured by Roche Molecular Systems.
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that occur

during analysis.

Table 8 Troubleshooting

Observation

Possible causes

Recommended actions

Faint or no signal from
both the AmpF(STR™
Control DNA 007 and the
DNA test samples at all
loci

Incorrect volume or absence of
AmpF(STR™ PCR Reaction Mix, SGM
Plus™ Primer Set, or AmpliTaq Gold™
DNA Polymerase

Repeat amplification.

No activation of AmpliTag Gold™ DNA
Polymerase

Repeat amplification, making sure to hold
reactions initially at 95°C for 11 minutes.

Master Mix not vortexed thoroughly
before aliquoting

Vortex the Master Mix thoroughly.

SGM Plus™ Primer Set exposed to too
much light

Store the Primer Set protected from light.

GeneAmp™ PCR System malfunction

Refer to the thermal cycler user’s manual and
check instrument calibration.

Use of incorrect thermal cycling
parameters

Check the protocol for correct thermal cycling
parameters.

Tubes not seated tightly in the
thermal cycler during amplification

Push reaction tubes firmly into contact with block
after first cycle. Repeat test.

Wrong PCR reaction tube

Use Applied Biosystems MicroAmp™ Reaction
Tubes with Caps or a MicroAmp™ optical 96-
well plate.

MicroAmp™ Base used with tray/
retainer set and tubes in
GeneAmp™ 9700

Remove MicroAmp™ Base from tray/retainer
set and repeat test.

Insufficient PCR product
electrokinetically injected

Prepare PCR product as described in Chapter 3,
“Electrophoresis” on page 25.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.
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Appendix A Troubleshooting

Observation

Possible causes

Recommended actions

Positive signal from
AmpF(STR™ Control
DNA 007 but partial or
no signal from DNA
test samples

Quantity of test DNA sample is below
assay sensitivity

Quantitate DNA and add 1.0-2.5 ng of DNA.
Repeat test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon™-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or
use the AmpF(STR™ MiniFiler™ Kit.

Dilution of test sample DNA in water
or wrong buffer (for example, TE
formula with incorrect EDTA
concentration)

Redilute DNA using low-TE Buffer (with 0.1 mM
EDTA.

More than one allele
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product

See “Stutter products” on page 74.

Mixed sample

Some but not all loci
visible on
electropherogram of
DNA test samples

Test-sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or
use the AmpF(STR™ MiniFiler™ Kit.

Test sample contains high
concentrations of a PCR inhibitor (for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon™-100 centrifugal
filter unit. Repeat test.

Poor peak height
balance

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler
parameters.

GeneAmp™ PCR System 9700
with Aluminum 96-Well block or
third-party thermal cyclers

Use Applied Biosystems GeneAmp™ PCR System
9700 with silver or gold-plated silver blocks only,
or the Veriti™ 96-Well Thermal Cycler.
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PCR Work Areas

Work area setup and labdesign............ ... i 115
PCRsetupworkarea......... ... 115
Amplified DNA workarea ... 116

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you
are using the AmpF(STR™ SGM Plus™ PCR Amplification Kit for:

e Forensic DNA testing, refer to “Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving,” National Institute of Justice, 1998

* Parentage DNA testing, refer to the “Guidance for Standards for Parentage
Relationship Testing Laboratories,” American Association of Blood Banks, 7th
edition, 2004

The sensitivity of the AmpF(STR™ Kits (and other PCR-based tests) enables
amplification of minute quantities of DNA, necessitating precautions to avoid
contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR Setup Work Area.

e Calculator

* Gloves, disposable

* Marker pen, permanent
¢ Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ Dipettors
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E Appendix B PCR Work Areas
Amplified DNA work area

¢ Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:

* GeneAmp'" PCR System 9700 with the Silver 96-Well Block
e GeneAmp'" PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The SGM Plus™ Kit is not validated for use with the GeneAmp""
PCR System 9700 with the Aluminium 96-Well Block. Use of this thermal cycling

platform may adversely affect performance of the kit.

e Veriti"" 96-Well Thermal Cycler
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C Ordering Information

Equipment and materials not included

Table 9 and Table 10 list required and optional equipment and materials not supplied

with the SGM Plus™ Kit. Unless otherwise noted, many of the items are available
from major laboratory suppliers (MLS).

Table 9 Equipment

Equipment Source

Applied Biosystems 3100/3100-Avant Genetic Analyzer Contact your local

Applied Biosystems 3130/3130x( Genetic Analyzer Life Technologies_
sales representative

Applied Biosystems 3500/3500xL Genetic Analyzer for Human Identification

Applied Biosystems 310 Genetic Analyzer

GeneAmp™ PCR System 9700 with the Silver 96-Well Block ' N8050001
GeneAmp™ PCR System 9700 with the gold-plated silver 96-well block 4314878
Veriti™ 96-Well Thermal Cycler 4375786
Silver 96-well sample block N8050251
Gold-plated silver 96-well sample block ' 4314443
Tabletop centrifuge with 96-well plate adapters (optional MLS

Table 10 User-supplied materials

Item? Source
AmpF(STR™ SGM Plus™ PCR Amplification Kit 4307133
3100 Analyzer materials
96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x! Genetic Analyzer capillary array, 36-cm 4315931
POP-4™ polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well ' 4316471
GeneScan™ 500 ROX™ Size Standard 401734
Running Buffer, 10X 402824
Hi-Di™ Formamide 4311320
DS-32 Matrix Standard Kit (Dye Set F) . 4345831
MicroAmp™ Optical 96-well reaction plate N8010560
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Itemt? Source
250-pL glass syringe (array-fill syringe) 4304470
5.0-mL glass syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100/3100-Avant instrument, refer to Appendix B of the 3100 Genetic
Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (Pub. no. 4335393).

3130x! Analyzer materials

96-well plate septa 4315933
Reservoir septa 4315932
3100/3130x! Genetic Analyzer capillary array, 36-cm 4315931
POP-4™ polymer for 3130/3130x( Genetic Analyzers 4352755
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 ROX™ Size Standard 401734
Running Buffer, 10X 402824
DS-32 Matrix Standard Kit (Dye Set F) 4345831
MicroAmp™ Optical 96-well reaction plate N8010560
Hi-Di™ Formamide 4311320

For a complete list of parts and accessories for the 3130/3130x! instrument, refer to Appendix A of the Applied Biosystems
3130/3130x! Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Pub. no. 4352716).

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4™ polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4" polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 44612614
Septa Cathode Buffer Container, 3500 series 4410715
GeneScan™ 500 ROX™ Size Standard 401734

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems 3500/3500xL
Genetic Analyzer User Guide (Pub. no. 4401661)

310 Analyzer materials

310 DNA Analyzer capillary array, 47-cm 402839
0.5 mL sample tray 5572

96-well tray adaptor (for 9700 thermal cycler trays) 4305051
GeneScan™ 500 ROX™ Size Standard 401734
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Itemt? Source
Running Buffer, 10X 4335643
Genetic analyzer septa retainer clips for 96-tube sample tray 402866
Genetic analysis sample tubes (0.5-mL) 401957
Septa for 0.5-mL sample tubes 401956
DS-32 Matrix Standard Kit (Dye Set F) for the 310 Genetic Analyzer 4312131
MicroAmp™ 8-tube strip, 0.2-mL N8010580
MicroAmp™ 96-well base (holds 0.2-mL reaction tubes) N8010531
MicroAmp™ 96-well full plate cover N8010550
MicroAmp™ 96-well tray/retainer set 403081
POP-4™ polymer for the 310 Genetic Analyzer 402838

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the 370 Genetic Analyzer User

Guide (Pub. no. 4317588).

PCR Amplification

MicroAmp™ 96-well tray N8010541
MicroAmp™ reaction tube with cap, 0.2-mL N8010540
MicroAmp™ 8-tube strip, 0.2-mL N8010580
MicroAmp™ 8-cap strip N8010535
MicroAmp™ 96-well tray/retainer set 403081
MicroAmp™ 96-well base N8010531
MicroAmp™ clear adhesive film 4306311
MicroAmp™ optical adhesive film 4311971
MicroAmp™ optical 96-well reaction plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
EDTA, 0.5 M MLS
Vortex MLS

t For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any

chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.
Handle chemical wastes in a fume hood.

Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

After emptying a waste container, seal it with the cap provided.
Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.
IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Specific chemical

handling CAS Chemical Phrase
26628-22-8 | Sodium Azide Sodium azide may react with lead and copper
plumbing to form highly explosive metal azides.
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Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

@ WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:
In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29cfr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

¢ Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:
Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization

(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Documentation and Support

Related documentation

Document title Pub. no.
AmpFSTR™ SGM Plus™ PCR Amplification Kit: Human Identification: Application Note 040302
3100/3100-Avant Data Collection v2.0 User Guide 4347102
3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0 User Bulletin 4350218
3100 Genetic Analyzer User Manual (Data Collection v1.1) 4315834
3100/3100-Avant Genetic Analyzers Protocols for Processing AmpF(STR™ PCR Amplification Kit PCR 4332345
Products User Bulletin

Applied Biosystems 3130/3100x! Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
Applied Biosystems 3130/3130x! Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems 3130/3130xl Genetic Analyzers AB Navigator Software Administrator Guide 4359472
Applied Biosystems 3130/3100xt DNA Analyzers User Guide 4331468
Applied Biosystems 3500/3500xL Genetic Analyzer Quick Reference Card 4401662
Applied Biosystems 3500/3500xL Genetic Analyzer User Guide, Data Collection v1.0 4401661

Applied Biosystems 3500/3500xL Genetic Analyzer User Bulletin: Solutions to issues related to software, data, 4445098
hardware, and consumables

Note: Additional user bulletins may be available at www.lifetechnologies.com

Applied Biosystems 3730/3730xl Genetic Analyzer Getting Started Guide 4359476
GeneAmp™ PCR System 9700 Base Module User’s Manual N805-0200
Veriti™ 96-Well Thermal Cycler AmpF(STR™Kit Validation User Bulletin 4440754
Quantifiler™ Kits: Quantifiler™ Human DNA Quantification Kit and Quantifiler™Y Human Male 4344790
DNA Quantification Kit User’s Manual

PrepFiler™ Forensic DNA Extraction Kit User Guide 4390932
GeneMapper™ ID Software Version 3.1 Human Identification Analysis User Guide 4338775
GeneMapper™ ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial 4335523
Installation Procedures and New Features for GeneMapper™ /D Software v3.2 User Bulletin 4352543
GeneMapper™ ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper™ ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper™ ID-X Software Version 1.0 Reference Guide 4375671
GeneMapper™ ID-X Software Version 1.1 (Mixture Analysis) Getting Started Guide 4396773
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Documentation and Support

Obtain SDSs
Document title Pub. no.
GeneMapper™ ID-X Software Version 1.1 (Mixture Analysis] Quick Reference Guide 4402094
GeneMapper™ ID-X Software Version 1.2 Reference Guide 4426481
GeneMapper™ ID-X Software Version 1.2 Quick Reference Guide 4426482

Portable document format (PDF) versions of this guide and the documents listed above
are available at www.lifetechnologies.com.

Note: To open the user documentation available from the Applied Biosystems web site,
use the Adobe » Acrobat » Reader » software available from www.adobe.com.

Obtain SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/support.

Note: For the SDSs of chemicals not distributed by Life Technologies, contact the
chemical manufacturer.

Obtain support

For HID support:

¢ In North America - Send an email to HIDTechSupport@lifetech.com, or call
888-821-4443 option 1.

* Outside North America — Contact your local support office.
For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the website, you can:

* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
¢ Submit a question directly to Technical Support

* Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

¢ Obtain information about customer training

¢ Download software updates and patches
Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant this product as set forth
in the Applied Biosystems 3500/3500xL Genetic Analyzer — Instrument Limited Warranty.
If you have any questions, please contact Life Technologies at thermofisher.com/
support.
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